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Getting Started

How to use this manual
This section, Getting Started, explains how to install and run Exposure. It also gives an overview of
some of the basic concepts. We recommend reading it all the way through before starting to use the
program.

The Organizing section gives an overview of Exposure’s image management features. The information
in this section is only applicable to Exposure’s standalone mode. This is where we show how to bring
images into Exposure, how to tag and filter images, and how to print and export photos.

The Editing section covers Exposure’s features for modifying images, whether using the standalone or
as a plug-in. This is where you’ll learn about editing panels like Basic, Color, and Tone; using brushing
and masking tools, and editing with layers.
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You’ll also find useful guidance in Exposure’s hover help. These are small text overlays that appear
when you hover your mouse over an interface element. The hover help gives a brief description of the
control.

Installing Exposure

Download the Installer
Exposure Software is distributed using internet downloads. Download links are available at three
locations.

Trial users: Current download links are available after entering contact information by going to the
Trial page on the website.

New software purchase: The order confirmation email will include a link to the download page and
your license number. If you already have the trial installed, you don’t need to download again.

Existing customers: Current downloads as well as a link to prior versions are available for existing
customers through the Support tab on our website.

Click the download link appropriate for your operating system. The installer file will be saved to your
Downloads folder. The transfer may take several minutes to complete.

Run the Installer
Navigate to your Downloads folder, and double-click the installer file to open it. Your computer’s
security system may ask if you trust the application. Allow it to proceed.

License Agreement

The installer window opens with the License Agreement. Read it and confirm you agree. Note that
sometimes the installer window may hide behind another window. If you do not see it, move or close
the top windows.

Host Selection

The installer will search your computer for compatible host applications and list them. Select all
programs you wish to install your program(s) to as plug-ins. Exposure and Snap Art will also
automatically be installed as standalone applications. If you only wish to use the programs in
standalone mode, do not select any hosts.

If you do not see your host software version, you will need to do a custom installation.
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Click Continue to complete the installation. Your computer's security system may ask for permission to
proceed. Enter your computer login password if prompted.

Install Complete

When the installation is complete, it will tell you your software is ready to use. Click Finish to complete.

Launching Exposure
The Exposure X6 is designed to fit into any photography workflow. It will work as a standalone image
editor, as a Photoshop plug-in, and as an external editor from Lightroom.

Standalone
Find Exposure X6 in your Applications folder (Mac) or Start Menu (Windows).
Click the application to launch.

Mac: Applications/Exposure X6
To pin the application to your Dock, open Exposure and then drag the icon to the left in the Dock.

Windows: Start Menu > Exposure Software/Exposure X6
To pin the application to your Taskbar, open Exposure and then right-click the icon and choose Pin to
Taskbar.

If it’s your first time using the software, our Getting Started video is an introduction to using Exposure.

When using the standalone version of Exposure, you can launch images directly in other programs. Our
Using External Editors video demonstrates how to integrate all your software into one central
post-processing tool.

Adobe Photoshop Plug-in
Open an image in Photoshop.
Select the layer you wish to edit.
Go to Filter > Exposure Software > Exposure X6.
Make all desired edits.
When complete click Apply. The changes will be applied to a new layer in Photoshop.

Exposure easily integrates into other photo editors. Our Getting Started - Photoshop video
demonstrates how to access and use Exposure from within Adobe Photoshop.

Adobe Lightroom External Editor
Select an image in Lightroom.
In the Lightroom menu bar, select Photo > Edit In > Exposure X6.

8

https://exposure.software/tutorial/getting-started/
https://exposure.software/tutorial/using-external-editors/
https://exposure.software/tutorial/photoshop/


You can also right-click on an image and choose Edit in > Exposure X6.
Note: if sending multiple images to Exposure, use the right-click Edit in > Exposure X6 path.

Lightroom gives you choices on how to send images in the Edit Photo dialog.

Edit Photo with Exposure X6 Dialog

Edit a Copy with Lightroom Adjustments - This is the only option if you are sending a RAW or DNG
file. It’s also useful if you want to keep your original Lightroom file. A new file will be created based on
the Copy File Options. All edits made in Exposure will be saved to the new copy.

Edit a Copy - This creates a copy of the original file but does not include any of the adjustments you
made in Lightroom. It is useful if you want to edit a TIFF or JPEG differently than you did in Lightroom.
A new file will be created based on the Copy File Options. All edits made in Exposure will be saved to
the new copy.

Edit Original - This sends the original file to Exposure. It is useful if you want to permanently change a
TIFF or JPEG. All edits made in Exposure will be saved to the original file.

Copy File Options - Choose TIFF or JPEG file format. Exposure cannot edit PSD in external editor
mode.
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Set all other settings at your discretion. Exposure can edit them all.

Edit and Save file in Exposure - Make all desired changes in Exposure.
When your edits are complete click Save. The edits will be saved to the copy or original files and show
in Lightroom.

If you want to migrate your library from Lightroom over to Exposure, the migration tool makes it a
simple process. If you have an extensive image collection that you want to bring over into Exposure,
check out our Migrating from Lightroom video to see how.

Catalog Free Workflow
A catalog is a database that tracks all of your edits and organizing changes. The first generation of
photo editors made catalogs central to their design. People associate certain features with a catalog,
such as keywords, collections, and virtual copies. But catalogs aren’t necessary to support those
features – Exposure has them all and its catalog free-design gives you several benefits.

Exposure is also non-destructive, so it will never alter the original photos you edit. We demonstrate
how you can locate sidecar files, or backup your photos and edits easily in our Understanding
Exposure’s Non-destructive Workflow video.

Skip the import step
In catalog-based photo editors, you need to perform an import step before you can work with your
photos. In Exposure, you just navigate to your photos and start working. Exposure doesn’t impose an
additional layer of organization on your files and folders.  What you see in the folders interface is the
same as in your computer’s disk storage.

Bringing in photos to your computer for the first time is easy, thanks to Exposure’s fast and flexible tool
for copying from a camera card. You can immediately begin to process your images, even while they
are being copied.

Easy transfer of files to another computer
In Exposure, edits are stored in small metadata files in the same folder as your RAWimages. When you
copy or move a folder, the edits go with it. To copy between machines, just use a network or USB drive
to copy the files. On the new machine, open them in Exposure and your edits will be there already.

This makes syncing your edits while traveling or shooting on the road very easy.

In a catalog-based system, you’d need to export on the first computer, copy the exported files to the
new machine, and then import.
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Easy file sharing
Another advantage to Exposure storing edits alongside photos is that you can easily sync edits
between two computers. If you’re working in the field on a laptop, you can store your files in a cloud
syncing service like Dropbox and perform your edits using Exposure. When you get back to your
desktop computer, your files and edits are already there when you return. Any edits made on either
computer are quickly synced to the others.

Using the same method, it’s also easy to share your photo projects with another Exposure user. Just
share the folder using Dropbox or other file sharing service. When you edit a shared file, the changes
are saved in the metadata file and synced to the person you are sharing with. On their computer,
Exposure notices that the photo has been edited and updates the view to show the latest changes. This
enables very fast collaboration.

Check out our Collaborative Photo Editing video for a demonstration of how Exposure’s catalog-free
workflow enables you to work flexibly from multiple computers.

Backups are easy and safe
Backups are easy to do in Exposure. Just back up the folder containing your files, and your Exposure
edits are saved along with the photos they go with. In catalog-based editors, you have to remember to
back up both your photos and catalog, which are in separate locations.

Interface Overview
There are no modules in Exposure, so you can flexibly access any tools at any point in your workflow.
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1 – Dock - There are docks at each edge of Exposure’s window - top, bottom, left, and right. Each dock
holds collapsible panels with Exposure’s editing and organizing tools. Click each dock’s arrow button
to lock them in the open position. When docks are collapsed, they will automatically open when your
mouse cursor is near the edge of the window they are attached to.

2 – Quadrant - The side docks are divided into upper and lower sections, providing four separate
quadrants for locating panels.

3 – Panel - Panels contain a set of related controls. Browse Exposure’s creative looks in the Presets
panel, or apply edits to images with the tools on the Basic panel.

4 – Preview - Working area for processing images. Select photo layout options with the controls in the
top dock.

Managing Docks
Hiding the docks devotes more of the screen to your image, keeping you in the creative zone. When
docks are hidden, you can still access them by moving your cursor near the edge of the window. When
you move your mouse off of the docks, they will hide themselves again. The docks can be locked open
with the arrow button at the edge of the screen.

Show and hide docks quickly with keyboard shortcuts. TAB toggles the visibility of all open docks.
Toggle individual docks with Cmd or Ctrl, Shift, and an arrow key. For example, the left dock can be
closed with Cmd+Shift+Left Arrow (Mac), or Ctrl+Shift+Left Arrow (Windows).
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Customizing Panels
The panels, such as Basic, Color, and Metadata live within the docks on the left and right side of
Exposure’s window. Right click on a quadrant to configure its contents.

The check marks indicate whether a panel in this quadrant is visible or not. Select a panel from this list
to show or hide it.

The menu options Show All, Hide All, Expand All, and Collapse All, apply to all the panels within that
quadrant. Solo Mode only allows a single panel to be open at a time, which saves screen space on
smaller monitors. To change the arrangement of your panels, select Customize Panels.
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The quadrants in this view represent the top and bottom sections in Exposure’s left and right docks.
Drag and drop to change the order of the panels, or move them between quadrants. Click a panel
name to toggle it visible or hidden. Hidden panel names will have a strikethrough.

At the bottom of the panel is the option to Reset to Defaults. This will revert the panel placement and
visibility to the default configuration.

Viewing Photos
The Preview is the working area in the center of the screen for editing images. There are image view
options for this area that help simplify post-processing tasks.

The grid view displays images as thumbnails making it well-suited for browsing through archives and
organizing photos. When making detailed edits, such as retouching skin or whitening teeth, switch to
the single image view. Editing adjustments can be applied to images when in single image view or grid
view. To switch to a single image view, double click a photo from the grid.
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Displayed along the edge of each cell in the grid view is the image name, an adjustments toggle
checkbox, the Audition mode spotlight, and a pin. Select the pin to lock an image in that position. Use
the other cells to display other images in the folder. Choose new images in the folder with the arrow
keys. Press ESC to return to the grid view.

To display more than one image at a time in a single image view, choose from multi image layout
options in the top dock. In single image and in multi image views, use the filmstrip in the bottom dock
to navigate and select photos.

Comparison Views
Comparison views enable you to display several images side-by-side. Select layouts from the drop
down menu. The preview window displays the selected number of image cells.

Multiple Monitors
A second monitor provides more room to work. You can view images at full size on one screen, and
display the grid and all the editing tools on the other.

To activate the secondary display use Cmd+F11, or Ctrl+F11 on Windows. Independently toggle the
displays to full screen with Cmd+F and Cmd+Shift+F, and for Windows users with Ctrl+F and
Ctrl+Shift+F.
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The docks can be moved to the screen you prefer to work with. From the top menu, select Window >
Customize Windows. On the Preferences panel, select which monitor to place each of the docks.

The arrangement of the workspace can drastically impact your experience editing photos. Our
Customizing the Workspace video demonstrates how to create an interface layout that flows with your
style of working.

Preferences
Exposure’s Preferences allows you to control the look and behavior of Exposure. Each tab controls a
unique part of Exposure’s capabilities.

Opening Preferences
To open Preferences, use these menu commands:

● Mac - Exposure X6 > Preferences (Cmd+,)
● Windows - Edit > Preferences (Ctrl+,)
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Preferences Overview

Preferences window showing all sections on the left side.

General - Set the user folder location, control settings not contained in specific sections, and import
presets from earlier versions. Covered in this section.

Windows - Control fullscreen and secondary display window options for use on multiple monitors.
See Multiple Monitors above.

Panels - Customize the format, location and order of panels in the user interface. See Customizing
Panels above.

Controls - Choose where edit and metadata controls show in the top edit bar, preview grid, filmstrip,
and bottom filter bar.

Shortcuts - View and edit keyboard shortcuts.

Preview - Customize the information overlay shown with the preview image, the background color,
and how often multiple selection warnings are shown.

Export - Edit Export Presets for individual settings and create Export Profiles for specific scenarios.
Reference the Quick Export section of this guide.

External Editors - Setup and edit how Exposure sends images to other programs.

Paste Previous - Control what settings are copied and applied when using “Paste Settings from
Previous” (/).
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Camera Presets - Configure presets to automatically apply to RAW images from the specified camera.

GPU - Detect and set up how Exposure uses compatible Graphics Processing Units.

DNG - Setup integration with Adobe DNG Converter. DNGs are useful as an archive format and for
viewing and editing raw files from cameras that are not yet supported in Exposure. See DNG
Preferences.

General
Set the user folder location, control settings not contained in specific sections, and import presets
from earlier versions.

Preferences window with General section selected.

User Folder
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The User Folder is where Exposure stores settings and presets that you have made. You can change the
User Folder to share settings between computers, or to a desired location.
Learn More - Link to an article showing how to share user settings between multiple computers.
Default - Set the user settings to the default location.
Change - Move the user folder to a location of your choice.

Miscellaneous
Language - Default, English, Deutsch (German), and Français (French).
Default uses your computer’s language setting if available from supported translations.

Output in New Layer - Specific to Photoshop Plug-in use. All settings are applied to a new layer in
Photoshop.

Automatically apply previous settings - Specific to Photoshop Plug-in use. Settings from previous
use are applied when opening the plug-in. Preset the Reset button to remove them if not desired.

Participate in the Product Improvement Program - Exposure Software’s Product Improvement
Program is a voluntary way for our customers to help improve our products.
If you opt to participate, our products will collect information about how the product is used and then
periodically send it to Exposure Software’s servers. The information collected is completely
anonymous. It is used to analyze how our products are used so we can improve them to better meet
your needs.

Show hover help - Display help when the mouse hovers over a tool.

Show setting on preview - Display setting on main preview when mouse cursor is hovering over a
preset or history state.

Hover sliders to adjust with scroll wheel - Momentarily hover over a slider to adjust with the scroll
wheel.

Scroll wheel adjusts brush size - When brushing, the scroll wheel adjusts the size of the brush.

Warn if exiting with unsaved changes - Specific to Photoshop and Lightroom use. This option
prevents you from losing your unsaved changes if you accidentally close the program.

Optimize for sharing adjustments - Write adjustment parameters to disk immediately so other users
will see them quickly.

When a camera card is inserted, launch Copy Photos From Card dialog - When Exposure is running,
open the Copy Photos From Card dialog when a camera card is inserted.
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Strip virtual copies on copy - Remove virtual copies from the new image when copying or duplicating
an image file.

Import Presets
Exposure will automatically look for and import presets from a prior version the first time it is opened.
The Import button is useful if this fails for some reason, or if new presets have been created in the prior
version since installation.

1. Click Import to detect and import user presets from the previous version.
2. A confirmation message will show the presets that have been imported.

Performance
This section allows you to optimize Exposure’s performance based on the expected speed and
capabilities of your computer.

Performance tab in Preferences set to default settings.

Memory/Speed Slider - Move toward Memory to use less system memory. This will cause Exposure to
be slower when navigating between photos.
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Move to Speed for faster operation. This will use more system memory.

Image RAM Cache (MB) - Amount of RAM memory allowed for image caching in Megabytes.
RAM cache stores images for the Fit/1:1 Preview mode, speeding up edits on a single image.
Reduce if experiencing memory related trouble with other applications.

Image Disk Cache (GB) - Amount of disk space allowed for image caching in Gigabytes. Disk cache
helps while filling grids of RAW files and when moving from image to image.

Thumbnail Cache Size - Amount of RAM allowed for storing thumbnail images so that they are
immediately available when you scroll back to them or jump back to a previously-viewed folder.
Set to Large if you want to see a lot of files at once or are navigating between folders a lot.
Set to Small if other operations are suffering or to prioritize editing single images.

Metadata Processing - Prioritize speed of scanning of images. Exposure scans image and sidecar files
for information like ratings, keywords, and collections.
Setting to Fast will prioritize quickly scanning large batches of images so you can use the metadata
search tools sooner.
Setting to Slow will save processor resources for other operations like editing or exporting.

Use memory-mapped file access over the network - When accessing files over the network, use
memory-mapping. This can increase performance, but may cause problems on unreliable networks.

Reset to Defaults - Return to factory settings found to work well on a range of computers.

Cache Disk Usage - Shows the size of Render and Metadata Caches for current and earlier Exposure
versions.
You can purge a cache to free up storage space. Check the desired version cache and click Purge.
The current versions’s Metadata Cache cannot be purged.

Thumbnail Cache Usage - View percentage of Thumbnail Cache that is used. If the percentage is very
high, consider increasing Thumbnail Cache Size.
The Clear button is used in troubleshooting scenarios to investigate editing, rendering, or export slow
downs.

Controls
Choose where metadata, rating, and rotate/flip controls show in the top edit bar, preview grid,
filmstrip, and bottom filter bar.

The Edit, Grid, and Filmstrip controls all have the same functions but can show in different places in
the user interface. Clicking any corresponding icon in any of the locations will apply the change to the
currently selected image(s).
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The Filter Controls all show at the bottom bar of the user interface. Clicking or changing these controls
will sort images in the current image folder and limit the number shown.

Use the Preferences Controls to set what icons you want to use and where they will show.

Controls tab of Preferences in default state.

Edit Controls
Edit Controls will show at the top bar in the Exposure window. These controls will edit the currently
selected image(s). By default they are off. Check any box to add the corresponding control icon to the
top bar.

Top bar with all Edit Controls On. Note filename (metadata), flag, stars, color, and rotate/flip icons.
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Grid Controls
These controls are available for images when in Grid view. By default they are set to Mini and all on.

Exposure in Grid view with all Grid Controls on. Note filename (metadata), flag, stars, color, and
rotate/flip icons on the active image.

Filmstrip Controls
These controls are available in the Filmstrip when the image is in Fit or 1:1 view.
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Exposure in Fit view with the filmstrip showing. Note filename (metadata), flag, stars, color, and
rotate/flip icons on the active image.

Filter Controls

Bottom bar with all Filter Controls on.

More Learning Resources
Visit the Exposure Software website for tutorial videos on a variety of topics. You can also find them on
our YouTube channel.

Sign up for our newsletter to be notified about each new video that we publish. We’ll also send
notifications about promotions and other special announcements. We are respectful of your time and
don’t send a lot of unnecessary messages - typically 2-3 per month.
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Visit us on social media and connect with other Exposure fans. We’re active on Facebook, Instagram,
and Twitter. On Facebook, there is an Exposure Users Group where you can share your Exposure edited
photos, solicit feedback, ask questions, and see inspiring images from other Exposure users.

Exposure's workflow is reliable and efficient, so you can focus on creating beautiful images. Check out
our Workflow Essentials video for a demonstration of the essential steps of the process.

Organizing

Working with Folders
You can access photos already on your computer using Exposure’s folders panel. There’s no need to
import images in order to start working with them. Just navigate to them using the panel and start
working.
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1 – Show subfolders - When enabled, shows images in subfolders or the active folder in Exposure’s
grid view.

2 – Add / remove bookmark - Click + to add bookmarks to the folders panel.  Clicking - removes the
currently active bookmarked folder.

3 - Bookmarked folder - Shows the bookmark, along with any subfolders of it. Click a folder to show
its files in Exposure’s grid view.

4 - Collection List - The list of photo collections. Collections are special folders that can contain
images from folders anywhere in your photo library.

5 - New Collection - Click to create a new collection or smart collection

Adding a Folder
To access a folder for the first time, you’ll need to create a bookmark. Bookmarks are folders that
you’ve selected to appear in Exposure’s folders panel. We recommend saving a bookmark for the
folder at the top level of your images on disk.

To add a bookmark, click Bookmark a Folder/Drive, then select a folder on your hard drive, a
removable hard drive, or folders from Dropbox or other cloud file syncing services.

Folder Operations
Right-click on a folder to open a context menu of available operations.

Folder context menu. Access by right-clicking a folder in the folders panel.
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Remove this Bookmark/Bookmark This Folder - Remove a bookmarked folder from the list, or add a
subfolder as a top-level bookmarked folder

Monitor Folder - Turns on folder monitoring using the selected folder. This allows you to
automatically select, apply metadata, and rename photos as they are added to the folder.

Show in Explorer/Finder - Opens the selected folder in the file browser for your operating system.

Rename - Brings up a dialog for renaming the selected folder.

Copy Item - Copy the selected folder to the clipboard. When it is pasted, it will be duplicated to the
new location.

Cut Item - Copy the selected folder to the clipboard. When it is pasted, it will be moved to the new
location.

Paste Item - Complete a previously started cut or copy operation.

Move to Recycle Bin/Trash - Move the selected folder to the operating system’s deleted files location.

New Folder
Brings up a dialog box for creating a new subfolder inside the selected folder.

Selected Files Move/Copy
Moves or copies files selected in the grid view to the selected folder.

Collections
Collections are special folders which group images from all over your hard drive. They are useful for
grouping images for portfolios, slideshows, photo books, and gallery showings.

To create a new collection, click the New Collection button and choose New Collection from the
menu. Enter a name for the collection in the dialog window. You can optionally add any selected
images to the new collection.

For a demonstration of using collections for fast and flexible photo organization without creating
duplicate files, check out the Managing Photos with Collections video on our website. The video
explains how to integrate each type of collection into your workflow.
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New Collection dialog

Smart Collections
Smart collections group photos from different locations in your photo library using search criteria. For
example, you could define a smart collection that lists all images with four or more stars.

To create a new smart collection, click the New Collection button and choose New Smart Collection
from the menu. The Create Smart Collection dialog will appear.

Create Smart Collection dialog.

Name the collection and then specify the criteria you’ll use to populate the collection. Criteria can
refer to a variety of metadata, including ratings, camera information, keywords, filename, and much
more.

Add new criteria with the Add Criteria button. You can specify whether to match all criteria, or any of
the criteria.
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Smart Collection From File List

You can also create smart collections from a file list. Instead of metadata criteria, you’ll enter a list of
filenames. Images whose name matches the filenames in the list are included in the collection. This is
useful for automatically selecting a list of filenames chosen by a client for printing or inclusion in a
book.

Copying images from a card
Accessing images on camera cards in Exposure is a straightforward no-import process. Exposure
copies files from your photo card onto your hard drive and then adds the folder bookmark in
Exposure’s folders panel if it isn't already present.

When a card is inserted into a card reader, Exposure will recognize the card and open the Copy Photos
From Card dialog. If you’ve turned off the automatic detection of camera cards, this process can be
manually initiated from the File menu.

Check out the Copying Photos from a Card video on our website for a demonstration of this process. It
shows you how to preview images on camera cards, efficiently make image selections, edit metadata,
apply creative presets, save backups, and more.

Exposure Copy From Card Dialog. A camera card is selected as the source to copy from.

1 - Select Source - Direct Exposure to the folders containing  images you wish to copy
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2 - Review Images - Browse, inspect, and select images to copy.

3 - Destination and Options - Select the save location, file name, keywords, and other organization
tools.

Select Source
Begin the process by selecting the location of the images you wish to copy. Exposure enables you to
copy images from multiple sources simultaneously to make this process quick. The copied files can be
automatically organized, eliminating headaches from shooting with multiple cards, multiple cameras,
or when working with other photographers.
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Exposure Copy From Card dialog. Select Source section.

1 – Location Shortcuts - Access recently used and common folder locations on your computer.

2 – Include Subfolders - View images contained in subfolders to browse images quickly.

3 – Delete After Copying - Automatically delete the selected images from the camera card after they
are transferred to the computer.

4 – Eject After Copying - Eject card from computer when the transfer is complete. This enables you to
safely remove cards when they are finished transferring.

5 – Transfer Data - Information about the current settings for copied images.

Review Images
Browse, identify, and select images to copy from the source locations. Quickly select all images
without creating duplicates when only new files on that card are displayed.
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Exposure’s Copy From Card dialog. Review Images section.

1 – Only New Files - Enable to only display images captured on that device since last ingested.
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2 – Grid/Single View - Display a grid of images as thumbnails, or a single image at a larger view.
Disclose and hide folder contents when the view subfolder option is active.

3 – Check All - Select all images available within selected cards.

4 – Uncheck All - Deselect all images.

5 – Thumbnail Size slider - Change size of images in grid.

Destination and Options
Set options for how copied files are handled in the third section. Include details for where the files are
saved, how they are named, and what metadata information to include with the images you transfer.

Destination

Specify the location where photos will be copied to. Include subfolders to automatically organize with
image metadata. You can have Exposure separate photos into folders by shoot date, camera model, or
camera serial number.
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The destination shown here will save images from the selected card and sort them into these folder
locations.
3 images – Desktop/Photos/Great Bear Media/20190831
11 images – Desktop/Photos/Great Bear Media/20191101
10 images – Desktop/Photos/Great Bear Media/20191102

1 – Standard Location - Select from locations on your computer such as Pictures, Documents, and
Desktop

2 – Other Folder - Specify a location, which could be on an external drive or a shared folder. This
includes generating subfolders. Subfolders generated using image metadata will organize images
automatically as they are copied.

3 – Make backup copies - For an extra level of precaution, create an immediate backup of all images
copied during each process.
4 - Convert RAW files to DNG - Launch Adobe DNG Converter tool on RAW files to convert them to
DNG. The RAW file is not removed from your system after converting to DNG.
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4 – Presets menu - Access file destination presets.

5 – Add subfolder item - Choose from a list of subfolder organization tools, including capture time,
and photo metadata like camera model or serial number.

6 – Delete item - Remove selected subfolder item.

7 – Edit item - Select from configuration options for selected subfolder item.

File Naming
Apply your favorite naming convention. Include the original file name, add custom text, or number
files in sequence.

These File Naming options also appear in the export dialog. Naming presets saved in this panel are also
available when Exporting.
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1 – Rename Copied Files - Click to apply your preferred naming convention to the images you copy.

2 – Presets Menu - Access file naming presets.

3 – Add - Select from flexible file naming assets such as Original Name, Capture Time, Numbered
Sequence, and more.

4 – Edit Item - Set options for selected file naming item.

5 – Extension - Set the file extension case and number of characters (tif or tiff, jpg or jpeg)..

6 – If File Exists - When faced with overwrite dialogs, set Exposure to ask or ignore prompts.

Metadata
Apply metadata to embed information into your image files as they are copied.

Exposure’s Copy From Card dialog. Metadata section.
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1 – Apply Metadata - Control what information is embedded in your image files as they are copied.

2 – Metadata Fields - Assign shared information for all images being copied, here.

3 – Keywords - Assign organizational keywords to copied images. See the Keywords section for more
information.

4 – Collections - Organize images into collections. Collections are groupings of photos for a specific
purpose, like a blog post or an album. See the Collections section for details.

5 – Presets - Select from creative presets, including custom presets you have defined. Choosing
multiple presets creates a separate virtual copy for each.

6 – Presets Menu - Access metadata presets.

DNG Conversion
Exposure supports DNG (Digital Negative) files that have been created in-camera or converted from a
proprietary RAW format. DNG conversion is useful if Exposure can’t process a particular RAW format
and in archival situations so that all of your original files can be stored in a single widely supported
format.

Exposure integrates with the Adobe Digital Negative Converter for fast and simple conversion.

Converting to DNG
Select a file, or group of files, you want to convert. See Selecting images for details.
Click Convert to DNG in the thumbnail window, or right-click an image and choose Convert to DNG
from the options list.
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Unsupported files in grid view showing the thumbnail and right-click Convert to DNG options. Note that
the Convert to DNG option will only show in the thumbnails of unsupported RAW files. The right-click
option is available for all RAW files.

Exposure will seamlessly convert the file(s) using the Adobe Digital Negative Converter. When
complete the new DNG files will show in the same folder as the original file.

If no converter is installed or detected, you’ll see this message.
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To install or configure the Adobe DNG Converter click Configure. Exposure will open the DNG section
of the Preferences dialog.

DNG Preferences
Open the DNG Preferences to download and/or configure the Adobe DNG Converter integration.

Location - The default installation location is automatically populated. If no converter is found at that
location this message will show.
Converter not found - find the install location above, or download and install it.

If you already have the DNG Converter installed, click the folder icon and navigate to the application
location.

To install the Click “download” to navigate to Adobe Digital Negative Converter website in your web
browser.

Download the DNG Converter from that webpage and install it to your computer.

Once the Adobe DNG Converter is detected, the Converter not found message is removed.
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Adobe DNG Converter Options
The Options relate to Preferences used by the Adobe DNG Converter application. The converter will
use these settings each time you use Convert to DNG.
Embed original RAW file - Embeds the entire non-DNG raw file inside the DNG file. This creates a
larger DNG file, but it allows the original raw file to be extracted later if needed.
Compressed - Lossy compression can significantly reduce DNG file size, but may result in some quality
loss.
Fast load data - Speeds loading images when adjusting settings. Increases DNG file size slightly.
JPEG preview - Speeds preview speed display of rendered images. Increase DNG file size slightly.

Selecting images
Selecting images is an important step in the Exposure workflow. Exposure provides several ways to
quickly select multiple images based on manual selection or matching metadata criteria. Once you
select a group of images, any changes you make will be applied to all of them. This allows you to set
organizational flags, apply a preset look, and export a group of images with just a few clicks.

Basic Image Selection
Basic image selection works similar to your operating system’s file management.
Click: Select an image.
Shift+Click: Select all images from the currently-selected image to the image you shift-click.
Cmd+Click (or Ctrl+Click on Windows): Add or remove a single image from the selected images. Hold
down Cmd(or Control) and click all the images you want to select.

Invert Selection
Invert Selection will select all images that are not selected, and deselect the images that are selected.

Use Edit > Invert Selection or the keyboard shortcut Cmd+U (Ctrl+U on Windows) to invert the
selection.

Deselect Images
Use Edit > Deselect all others or the keyboard shortcut Cmd+D (Ctrl+D on Windows) to deselect all
images.

Select Matching and Deselect Matching
Select images with similar attributes like rating, camera make, or lens focal length using the Select
Matching feature.
Choosing Deselect Matching allows you to remove images from the current selection that match
specific criteria.
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Right-click an image, click on Select Matching or Deselect Matching and choose the desired
matching criteria.

Select Group by clicking Grid Header
In grid view, click on a grid header to select a specific group. You can change the header criteria using
the Sort list found on the bottom dock.

Tagging Photos
Exposure enables you to categorize your image in various ways to help you keep your photo library
organized. You can assign flags, ratings, color labels, and keywords. Each of these items can be used to
sort and filter so you can find the image you need quickly.

Photo in Exposure’s grid view. Note the pick flag (bottom left), the four-star rating (center), and green
color label (bottom right). The cell background is also shaded to match the color label.

Flags
Images can be flagged as pick or reject, or they can be unflagged. When you first browse to a photo in
Exposure, it is unflagged.

In the grid view, click on the flag on the photo to cycle through the flag options. You can also right-click
the flag icon and select the one you want from the menu.

Flags can also be assigned with a keystroke. Press + to flag a pick, and - to flag as reject. Hold down the
Shift key while pressing + or - to navigate to the next image after setting the flag. This enables you to
assign flags to a group of images quickly.
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Ratings
Star ratings are for assigning a number to a photo. This often is used to indicate how good you think
the photo is, but can be used in other ways if needed. Exposure has a range of 0-5 stars.

In grid view, click the stars on the photo to set the star rating. Click it again to clear.

You can set star ratings with the keyboard too. Use the keys 0 through 5 to set that many stars on the
selected photo. Holding down the Shift key will navigate to the next image after assigning the rating.

Color Labels
Color labels give you a way to tag images for various activities. You can use color labels to indicate
which images are client picks, or images you’ll use in an album. It’s up to you to decide what the colors
indicate in your workflow.

There are five labels available - red, yellow, green, blue, and purple. In the grid view, click the color
label control on the photo to cycle through the colors. To assign a specific color, right-click on the
control and select from the menu.

It’s even easier to use the keyboard to set a color label. Press 6 for red, 7 for yellow, 8 for green, and 9
for blue. There’s no keyboard shortcut for purple - we ran out of number keys.

Keywords
Keywords are labels which identify images. Each image can have as many keywords as you want to
assign. You can use keywords to easily search for images later. For example, you may want to label
your best images with a ‘portfolio’ keyword in order to have quick access to all of your portfolio
images.

Keyword Hierarchies

Keyword hierarchies enable you to create a multi-level classification for your images. Parent/Child
keywords add an extra level of sophistication to organizing. They work great for taxonomic needs, like
a family and its members, animals, or geographic locations.

A simple example is travel keywords, where images would use keywords for locations visited.
Searching using the travel keyword will display all images taken while on the road.
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Metadata panel. Hierarchical keywords displayed.

Adding Keywords

Exposure’s keywords tools are in the Metadata panel.

Keywords section of the Metadata panel

Add a keyword to the selected image (or images) by typing in the Apply Keywords box. If you’ve used
the keyword previously, you can select it from the Keyword Library instead of typing it.

Right-clicking an applied keyword reveals a context menu.
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Context menu for a keyword applied to a photo.

The first element in this menu is the complete hierarchy for the keyword.

Remove removes the keyword from the selected images, but it remains in your keyword library and
does not affect other images.
Create Keyword Collection creates a smart collection containing all photos having the keyword.
Filter By filters visible images so that only photos having the keyword are shown.
Add to Set enables you to add the keyword to a keyword set.

Keyword Library

The Keyword Library is shown below the image’s keywords. This is where you can find all the
keywords Exposure has applied to your image, or which have been used in photos in your photos
library.

Right-clicking a keyword in the library brings up a slightly different context menu.

Context menu for a keyword in the Keyword Library

The first element in this menu is the complete hierarchy for the keyword.

Rename changes the name of the keyword. This affects all photos that have the keyword. Select
Parent enables you to choose a new parent keyword for the selected keyword.
Create Child Keyword creates a new keyword whose parent is the selected keyword.
Add to Set enables you to add the keyword to a selected Keyword Set.
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Create Keyword Collection creates a smart collection containing all the photos that have the
keyword.
Filter By filters visible images so that only photos having the keyword are shown.
Remove from Set removes the keyword from the Keyword Set.
Delete (not shown in the screenshot) removes the keyword from all photos in your photo library and
the keyword library.

The Keyword Library has three tabs - Recent, All, and Sets.

Recent

Keyword section of metadata panel with Recent tab visible

The Recent tab shows keywords that were recently applied to images.

All

Keyword Library section of metadata panel with All tab visible

The All tab shows the contents of the keyword library. Only a limited number of keywords can be
displayed, so if you have a large keyword library you may need to filter the display by typing in the
Filter Keywords box.
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To add multiple keywords to the library, click the Filter button and select Add. The Filter Keywords
box will become Add Keywords. Type keywords into Add Keywords and press enter to add them to
the keyword library.

Keywords can be part of a keyword hierarchy. For example, typing animal>bear in the Add Keywords
box adds a hierarchical keyword to the photo. When searching for keywords, photos with animal>bear
will be found by searching either for animal or bear.

Sets

Keyword Library section of metadata panel with Sets tab visible

The Sets tab shows keyword sets. Keyword Sets are groups of associated keywords. Create a new
keyword set by choosing Create Keyword Set from the menu to the right of the Add/Filter Keywords
box. Then, use the Add Keywords box or the keyword context menus to add keywords to the new set.
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Filtering and Sorting

Grid view with the Filter panel shown at the bottom of Exposure’s main window

The Filter Panel enables you to choose exactly which images are shown in Exposure’s central view
area, and in what ordering. Images are shown or hidden based on metadata criteria that you specify.

Filtering
Display images with flags by clicking the corresponding flag in the Filter Panel. For example, you can
hide all reject images by clicking both pick and unflagged. Click a flag a second time to remove it from
the filter criteria. Color labels are also available, and work the same way as filtering flags.

Similarly, you can show images with a certain number of stars. There is an operator button to the left of
the stars which allows more flexible filtering. You can choose to display images with four or more stars,
for example.

Click the key icon to filter by keyword. Enter keywords to filter on by typing them directly into the
Filter by Keyword box, or by selecting them in the Keyword Library.

You may also filter by entering free form metadata. Type the word you’d like to search for in the Filter
by Keyword box. This will search all metadata in your image library, and show only photos that match.
For example, you could enter the word Fujifilm in this box to locate any images shot on a Fujifilm
camera.

You can filter by ISO, shutter speed, lens name, capture time, camera serial number, and more.
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Sorting
You can change the order photos are shown in Exposure’s main window using the sort control on the
Filter Panel. Click it and select the item to sort on. You can sort by a wide range of metadata, including
file name, capture time, flag, color label, or rating. Sort options other than File Name will group photos
together in the grid view.

Change the sort order by clicking the sort order arrow icon to the right of the sort menu.

Filter Presets
Filter Presets retain a set of filter and sort options for later reuse. Click the gear menu on the left side of
the Filter Panel to access Exposure’s default Filter Presets, in addition to any presets you have saved.
Save a new preset by choosing the filter and sort options you want to save, then selecting Save as New
Preset from the gear menu.

Virtual Copies
Virtual copies are duplicates of an image that do not take up any extra disk space. They enable you to
create multiple separate versions of a single image, each with its own set of edits. This is perfect for
trying out different creative treatments. The virtual copy does not duplicate the file on your hard drive.
Instead, Exposure stores the copy information in the master photo's sidecar file.

To create virtual copies, right-click on the image and select Create Virtual Copy. Virtual copies retain
any edits that you’ve made to the master image up until that point. Once a virtual copy is created,
Exposure treats it as a separate photo. Any edits made to the master image or the virtual copy will not
apply to the other photo.

You can make as many virtual copies you want. They are always kept in the same folder as the master
image, although virtual copies can be part of collections separately from their master image.

You can navigate from any virtual copy to its master image by right-clicking the image and selecting
Jump to Master.
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Virtual copy in Exposure’s grid view (left) and detail of the Metadata panel showing Copy Name. Note the
virtual copy indicator in the bottom left corner of the thumbnail.

In the grid, virtual copies can be identified with the turned up corner icon in the bottom left.

For a demonstration on how easy it is to integrate these tools in your workflow, check out the Virtual
Copies video on our website.

Printing
Printing your photos directly from Exposure saves you the extra step of sending your images to an
outside app in order to print them. Some of Exposure’s helpful features like integrated watermarks and
the ability to print a grid of images as a contact sheet make the process especially flexible.

Open Print Dialog
To start printing, first select the image or group of images you want to print.
Choose File > Print from Exposure’s menu bar, or use the keyboard shortcut: Cmd+P (Mac) and Ctrl+P
(Windows).

Exposure begins preparing the images and then shows you a preview of your image or images as they
will appear at your selected page size. You can resize the Print dialog to make it larger, in order to see
the images more clearly.
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Print Options

Print window with four images.

Page Setup - Set or change your printer, paper size, and type. This opens the Page Setup dialog in your
Windows or Mac operating system. You’ll be able to set your printer and paper formatting options.
This is at the bottom right of the Print window, but is a useful first step if you have not printed with
Exposure before or need to change your printer settings.
Closing the operating system print dialog will return to the Exposure Print window.

Preset - Quickly choose print settings with premade settings. These presets contain all your print
settings, including paper size and orientation from your operating system’s Print dialog, so you can
re-apply them with a single click.
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Exposure comes with a number of presets that cover common paper sizes and printing choices. You
can create your own as well.

Units - Set the units to target a specific print size. Inches, Millimeters, and Points.

Margins - The area between the edge of the paper and your image(s).
The margins default to the printer’s printable region, but you can adjust them to taste. For example
you might reduce them for borderless printing, or adjust them as needed if you’re printing a grid of
images.

Grid and Grid Spacing - The Grid adjustments enable you to print multiple images per page. This
saves paper when printing small photos. It’s also useful for contact sheets.
Use the Rows and Columns sliders to set the number of images to print on each page. Then fine tune
the image spacing on your grid with the Grid Spacing controls.

Cell Size - Define the size of the image cells on your page. Your photos will expand to fill the cells.
If you’re creating prints of a specific size, keep in mind that increasing the grid rows, columns, or
spacing will lower the range of the cell size sliders.

Cell Options - Adjust how images appear in cells.
Zoom Fit ensures that the entire image fits within the cell. Fill, which fills the entire cell with your
photo. This can cause photos to be cropped if they don’t match the shape of the cell. You can adjust
the crop position with the crop slider.
Match Orientation will rotate the image if necessary to match orientation of the cell.
One Image per Page will fill all cells with the same image.
Keep Square will force Cell Height and Width to be the same.

PPI - Set the pixel density (pixels per inch) of the image sent to the printer. More pixels means more
sharpness and detail. We recommend using at least 300 PPI when printing photos.
Note that PPI and DPI (dots per inch) are different terms in printing. PPI is the resolution of pixels
recorded in the digital file that is sent to the printer. DPI is the output resolution of the ink dots applied
by the printer. The conversion from PPI to DPI is handled by your printer’s software.

Watermark - Select a watermark to apply to the image. The dropdown displays a list of any
watermarks that you’ve created. You can also create a watermark from scratch by choosing Edit
Watermark. See the Watermarks section in this guide to learn more.

Output Sharpening - Add sharpening to compensate for ink spread. We recommend starting with a
low sharpening amount because it provides a noticeable but not dramatic sharpening and is effective
for most photos.
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A small sharpening radius will sharpen only fine details like hair. A wide radius will sharpen larger
details and can be used if your print is to be viewed at a distance. The media type list will set an
appropriate radius for your paper type.

View Options - You can view the preview in several different ways. These include different viewing
options like Fit, Fill, and 1:1.
Because 1:1 displays the image without scaling, it’s useful to see if your image looks good.

Print - When you’re ready to print your images, click Print. Your operating system’s print dialog will
appear, enabling you to select your destination printer and adjust other printer settings.

Exporting
Exporting is the process of applying changes to a photo and writing an image file to disk. You can
upload, print, or email the finished image.

To begin, select the files you want to export. See Selecting Images for details about how to do that.

Once you have your files selected, open the export window by right-clicking one of the selected
photos, then selecting ‘Export...’ from the menu. Or by pressing Cmd+E on macOS or Ctrl+E on
Windows.

Select the desired export options on the Export dialog. When you’re ready to start the export process,
click the Export button at the bottom.
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Export Options

Exposure’s Export dialog. This is where you’ll select the location, name, format, and other options for
exported files.

The Export dialog is divided into five panels - Destination, File Naming, File Settings, Metadata, and
Image Sizing. Each has a presets menu which can be accessed by clicking the gear icon. Export presets
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store settings for a particular panel. Choose saved presets or create new ones from this menu. You can
also select Manage Presets, which provides an interface for importing, exporting, and renaming
presets.

Destination

Export dialog, Destination panel

The Destination panel is where you’ll specify where the exported photos are saved. Choose the base
location using the radio buttons. You can also choose to create a subfolder hierarchy using the
Generate Subfolders list.

For each folder in the Generate Subfolders list, you can construct a name for the subfolder using
various items, including the original name, capture time, a sequence, or even custom text you are
prompted for when you export. See Naming Templates for more details.

The After Completion item specifies an action to perform after the export completes. You can choose
No Action, Show in Explorer, Open with Application, Open with External Editor, and Open URL.
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File Naming

Export dialog, File Naming panel

Select the filename for exported files from the File Naming panel. You can choose to retain the original
filename or to use a naming template which constructs the name using information such as original
name, capture time, sequence number, and more.

The Extension checkbox enables you to choose whether the generated file has an upper or lowercase
extension.

If File Exists selects the action to take if a file with the same name already exists in the destination.
Exposure can prompt you what to do, keep both, replace the file, or skip it.
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File Settings

Export dialog, File Settings panel

The File Settings panel enables you to select the file format, color space, and sharpening options for
the file.

File Type options include JPEG, TIFF, PSD, and Original formats. Original writes the file using the file’s
original format. When Exposure writes a RAW file using the Original option, it will also write a standard
XML file containing the associated metadata in the same location. Image editors able to read standard
file metadata will be able to interpret this information.

Some export formats provide additional file options. The JPEG option has a quality slider. Low values
create a low-quality image that doesn’t take up much disk space, and higher values create a
high-quality image that is larger.

TIFF and PSD both offer a bit-depth option. We recommend using 16-bit for the highest quality. 8-bit is
best used only if you need compatibility with older applications.

The TIFF option also has a compression option. You can choose ZIP, none, and Original. ZIP is
preferred since it creates a smaller file with no loss in quality.

Color Space specifies the industry standard color space used for the image. We recommend using
sRGB for images that will be used on the web and in social media. Adobe RGB or ProPhoto should be
used in print applications. Check with your printer to see which color space they prefer.

Enable Output Sharpening to perform sharpening designed to compensate for ink spread in your
destination print process. The Amount menu specifies the strength of the sharpening. Select from
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Matte, Luster, or Glossy to set the sharpening radius for that paper. Or adjust radius directly for other
media types.

Metadata

Export dialog, File Settings panel

The Metadata panel enables control of the metadata included in the exported file.
Include: All Metadata, Copyright Only, Copyright and Contact Info Only, or No metadata.

There are separate checkboxes which omit location info and keywords.

The Watermark menu enables you to choose a watermark to appear on exported files. Watermarks
designs may contain both text and images. See the Watermarks section to learn how to design them.

Image Sizing

Export dialog, File Settings panel

Select the size of exported images using the Image Sizing panel. Enable resizing with the Resize to Fit
checkbox. If this checkbox is turned off, images will be exported using their original size.
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Exposure only downsizes images. We recommend checking out Blow Up, our top-quality upscaling
application, if you need to enlarge photos.

Exposure resizes using several strategies:
● Dimensions - Set the width and height dimensions in pixels or real world units. If the icon

between width and height is locked, proportions are constrained to match the original image.
If it is unlocked, stretching may occur. The Match Orientation swaps the dimensions if
necessary to match the orientation of the original image. This is helpful when resizing portrait
and landscape shots in the same group.

● Long edge - Ensures that the longest edge of the exported image is restricted to the chosen
length

● Short edge - Ensures that the shortest edge of the exported image is restricted to the chosen
length

● Height - Ensures that the height of the exported image is restricted to the chosen length
● Width - Ensures that the width of the exported image is restricted to the chosen length
● Megapixels - Limits the total number of pixels by shrinking the image until its Width x Height is

less than the specified value
● Percentage - Reduces the images width and height to the specified percentage.

Quick Export
Quick exports enable you to specify Export recipes which can be quickly reused. This greatly speeds up
frequently used export operations. Save variants for web, publishing, and more, each with different
settings and to different folders, with a few quick mouse clicks.

To create Quick Export recipes, open the Preferences dialog and choose the Export option from the list
on the left side.
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Preferences dialog showing Export Profiles

This window lists the Export Profiles that have already been created. Exposure ships with several
starter profiles which you can use directly or modify for your needs. Each profile is defined by five
export presets representing the settings for each of the sections in the Export dialog.

Creating Export Profiles

To create a new Export Profile, click Add Export Profile. Give the new profile a name and then choose a
preset for each section. Choose a position for the profile in the list. Note the number next to the first 10
profiles. This is the shortcut key you’ll use to apply the Export Profile when you use it.

If you need to create a preset for one of the Export dialog sections you can do so by clicking the Select
Preset Type menu at the top of the screen. Select a section, adjust the panel options as you wish, then
save the preset using the gear menu. This saves a trip to the Export dialog to create or edit Export
presets.
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Performing Quick Exports

Start a Quick Export selecting the images to export, then right-clicking a selected image. From the
menu that appears, choose Quick Export, then the Export Profile you want. The export process with
start, exporting each selected image using the options specified.

You can also start a Quick Export using the keyboard.press Cmd+Shift+E (Ctrl+Shift+E on Windows).
The Quick Export dialog will come up showing a list of Export Profiles.

Quick Export dialog

Click a profile or type the number next to it to start exporting. You can also select the Select Multiple
option at the bottom to run multiple exports in one operation. Doing so enables you to select multiple
Export Profiles. Click Export after making your selection to initiate the sequence of exports.
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Check out the Preparing Photos for Social Media video on our website for a demonstration of
integrating Exposure’s quick export recipes in your workflow.

Naming Templates
A naming template is a recipe for how to name files and folders in Exposure. Naming templates can
help you enforce consistent naming for photos as they are brought into your photo library and
exported for use elsewhere. In the Copy Photos from Card and Bulk Rename, and Export dialogs,
naming templates are used in the Destination and File Naming sections.

Naming templates are a sequence of components, which, when put together, form the name of the file
or folder. Naming templates don’t include the file extension, which is set by Exposure according to the
type of file being copied, renamed, or exported.

Naming components show an example of the text they will be replaced with, so you can verify that the
name will be generated as desired. When you select a naming component, a box is revealed with the
type of the component and a delete button for removing it from the template. Some components have
additional settings which can be changed in this control.

File naming template from the Export dialog. The template includes the original name, custom text to
add a dash, and an ‘Ask’ custom text component. Exposure will prompt for this text when the export is
performed.

The Original Name component is replaced with the original name of the photo on disk, not including
extension.

Number Suffix is replaced with a number sequence from the original filename. This is useful if you
want to convert a generic filename like IMG_1498 to something more meaningful, like
Jane-Smith-Studio-1498, preserving the sequence number assigned by your camera.

Copy Name is replaced with the contents of the Copy Name field in Exposure’s metadata panel.
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Custom Text is replaced with custom text you specify. Select the Ask option to prompt for the custom
text when the copy, rename, or export operation is executed.

Sequence is replaced with a number from a sequence. Each time the template is used, the number is
incremented by one. In the configuration options for the sequence, you can specify the number of
digits shown using the format menu. Leading zeros will be added to make the sequence number have
the specified number of digits.

Click the edit button to change the starting number for the sequence. You can also specify separate
sequences for different situations using the Sequence ID menu. Each sequence can have a different
starting number, and each can optionally reset at each run.

Capture Time and Capture Time are replaced with times recorded in a photos metadata. You can
specify a date/time format from the menu. The custom option enables you to specify your own
formats. See the Custom Time Formats section below for more details.

The Metadata component is replaced with information from the photo. Choose the specific metadata
item from the menu. Available options include dimensions, capture info (exposure time, f--stop, ISO),
camera info (make, model, serial number), lens, photographer details (name, copyright, email), and
tags (flag, color, rating).

Custom Time Formats
The following expressions may be used when specifying your custom time format.

Expression Meaning

d The day as a number without a leading zero (1 to 31)
dd The day as a number with a leading zero (01 to 31)
ddd Abbreviated day name (e.g., "Sun", "Mon", etc.)
dddd Full day name (e.g., "Sunday", "Monday", etc.)
M The month as a number without a leading zero (1 to 12)
MM The month as a number with a leading zero (01 to 12)
MMM Abbreviated month name (e.g., "Jan", "Feb", etc.)
MMMM Full month name (e.g., "January, February", etc.)
yy The year as a two digit number
yyyy The year as a four digit number
h The hour without a leading zero (0 to 23 or 1 to 12 if AM/PM)
hh The hour with a leading zero (00 to 23 or 01 to 12 if AM/PM)
H The hour without a leading zero (0 to 23)
HH The hour with a leading zero (00 to 23)
m The minute without a leading zero (0 to 59)
mm The minute with a leading zero (00 to 59)
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s The second without a leading zero (0 to 59)
AP or A AM or PM
ap or a am or pm

All other characters appear as-is.  For example, specify "yyyy-MM" to get a dash, as in "2016-09".

In order to produce cross-platform file names, some invalid characters will be replaced with "-".

These characters are invalid: \ / : * ? " < > |

Characters enclosed in single quotes will not be interpreted as expressions. Use two single quotes in a
row to produce an actual single quote.

Watermarks
Adding watermarks to your photos is a great way to put your creative mark on your work. Watermarks
provide a way to showcase your brand, and ensure that your work is not used without your
permission.

Watermarks are collections of images and text placed on top of a photo. They may include your name,
studio information, technical details, or your logo.

Adding watermarks to images is usually one of the last steps of the photo editing process, when
exporting or printing finished files. On the Export dialog, the watermark selection appears in the
Metadata section. When printing, it appears in the printing options on the left side of the photo
preview.

Open the watermarks menu to reveal a list of watermark designs. Exposure includes a copyright
watermark which places the text from the copyright metadata field in the bottom right corner of your
photo. Once a watermark has been selected, you can preview it by hovering over the magnifying glass
icon.

Designing Watermarks
Create and edit watermark designs by selecting Edit Watermarks from the watermark menu.  There are
three types of watermark elements available - text, image, and metadata. Designs can incorporate any
number of these elements in a variety of layouts.

Save watermark presets for convenient reuse. Watermark designs can apply a studio name or logo,
copyright information, or the image filename for use when printing contact sheets.
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Edit Watermarks dialog. Use the tools on the left panel to add and edit watermark items.

Watermark Item - Hides the controls for the watermark item..

Item Type - Set the item type. Text, Image, and Metadata items are available.

Save As… - Saves the watermark design as a watermark preset for later reuse.

Move/Rotate - Click to enable the placement and rotation of the watermark item

Add Watermark Item - Add a new watermark item to the design.

Preview - Display of the current watermark settings on this panel.

Text Items
Text items include text you specify in the watermark design. Each text item has its own set of controls
for font, style, size, and color. Set parameters for each item to create sophisticated arrangements.

Image Items
Image items place images in the watermark design. Images must be PNG, JPG or TIFF format. We
recommend using PNG and TIFF images with transparency. You can specify the size, position, and
opacity of the image in the design. It’s also possible to add a drop shadow to set the image item off
from its background.
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Metadata Items
Metadata watermark items are similar to text items, but their text is drawn from the photos metadata
information. Metadata text can include ownership information such as copyright, studio name, or
website. It can also include technical information about the photo, such as the f-Stop and ISO, or the
camera, lens, and serial number.

Metadata
Metadata is any information related to your photo. Some examples of metadata are camera, lens and
shot data, copyright and owner information, and ratings and keywords. Metadata information is
grouped together on the Metadata panel, found in the bottom section of Exposure’s right dock.

Metadata panel.
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1 - File Data - The file name, copy name, image dimensions, and file size are shown here. The capture
time can be adjusted for individual files, and groups of images.
2 - Capture Settings - The exposure time, f-stop, ISO, and focal-length are embedded in the image file
when it’s captured.
3 - Camera and Lens - The camera make, model, and lens that were used to capture the photo.
4 - Copyright Data - Protect your work with the information in these fields. Enter Copyright, Name,
Email, Address, Title, and Caption. Saving presets with frequently used information speeds up
applying metadata. Click the gear icon to access preset management tools.
5 - Tags - Tag images with flags, star ratings, and color labels to sort and filter images in Exposure.
6 - Collections - Create new image collections by typing a name in the text box, or click the icon on the
right to select from existing collections. Learn more about Collections in this section.
7 - Keywords - Apply keywords to images in this section. Type them into the field, or select from
existing keywords with the button on the right. Visit the Keywords section to learn more.

Quickly filter images using keywords on this panel. Right-click on a keyword and select “Filter By.”
Then, Exposure will display all the images in your library with that keyword.

Keywords can be added at the beginning of post production, when images are copied from the camera
card. This helps organize your library from the first step.

See the Keywords section for more details.

Keyword Library
Keywords are a great way to categorize photos efficiently. Once applied, they can be used to sort and
filter images, and are often required for selling stock photography. Learn more about working with
keywords in this section.
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Metadata panel. Keyword Library section disclosed.

For additional speed when applying keywords, use keyword sets to apply the same group of keywords
to multiple images. Keyword sets can be applied all at once, which helps keep them consistent.

When making Keyword sets, the quickest way is to add the all at once. On the Sets tab, change the
search filter to “Add,” then type in all the keywords you like. Another way to make a keywords set
quickly is to select one representative image from a shoot, and then apply your keywords to it. Once
complete, multi-select all the keywords you want in the set, right-click and choose ‘Add to Set,’ and
then ‘New Set. It’s faster to create keywords directly in the set, rather than moving them around after
you make them.

Editing

Introduction to Editing
At the heart of Exposure is a sophisticated modern image processing engine. Built for a wide range of
operations from everyday edits to accurate film simulations, it handles high-quality editing of RAW ,
DNG, JPEG, PSD, PNG, and TIFF images. When edits are complete you can export in JPEG, TIFF, or PSD
format.
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Exposure easily integrates with Photoshop, including supporting PSD files. Check out the Working with
Photoshop Files video on our website for a demonstration of the possibilities of using that format.

Edits to photos are handled in a particular order. Crop and rotate, lens correction, and operations on
the Transform panel are handled first. Next Exposure processes edits in layers in order from bottom to
top. Read all about layers in the Layers Panel section of this manual.

Exposure's workflow allows for applying adjustments to lots of images quickly. There are several
techniques for editing groups of images demonstrated in our Batch Editing video.

The Overall Intensity slider, located in the top quadrant of the rightmost dock, can be used to reduce
the effect of all image adjustments. It is often used to attenuate a too-strong effect.

Below it is the Process Version control. Edits in Exposure are performed using a specific process
version. Process versions exist for compatibility. Future versions of Exposure will yield visually
equivalent results for a given photo edit.

When Exposure first sees a photo, it assigns the latest process version. The photo retains that process
version until it’s manually changed using the Process Version control.

Performance
Exposure is optimized to use multiple CPU cores. It also uses your computer’s specialized graphics
hardware to improve image processing speed. It will automatically detect any installed GPUs and use
them in concert with the CPU to optimize speed.

Exposure also uses a disk cache for quick navigation between images.

Performance can be adjusted using the Performance and GPU panels in Exposure’s preferences dialog.
See the Preference section for more information.

Working Color Space and Precision
Exposure  is designed to retain optimal quality in your images at every step. It uses the wide-gamut
ProPhoto color space for its internal calculations.

Exposure performs computations using high precision floating point numbers. This prevents rounding
errors from degrading the quality of images as they are processed.
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Camera profiles control the interpretation of color from the RAW data of particular cameras for
real-world accuracy. Our Camera Profiles video demonstrates how to integrate the use of color checker
systems in your workflow with Exposure.

Navigator Panel
The Navigator panel houses controls for the preview. This panel displays the selected image, and when
the photo is larger than the monitor can display, a frame representing the magnification level. Drag the
frame within the navigator to relocate the preview to that location.

At the top of the panel are the zoom amount and the view selections. The zoom amount is displayed
as a percentage of the current magnification in the preview. Select Grid to return to that view. The
current view is highlighted. Select Fit to scale the image to fit the screen in the preview. Press 1:1 to
scale the image to 100% magnification.

The view extents box displays the current view of the image in the preview. Move to pan view around
the image.

Making Selections: Masking and the Brushing Panel
Exposure enables you to apply edits only to the areas you select, and seamlessly blend any of the edits
you make. These selected areas are called masks. They, and are also known as selections or local
adjustments.

As covered in the Layers section above, each layer will have a set of adjustments and a mask where
those edits are applied.

The Brushing panel contains all the tools used for creating a mask.
Brushing allows you to use the cursor in a brushing motion to select where edits are applied.

70

https://exposure.software/tutorial/camera-profiles/


Gradient controls enable you to make seamless, natural fades between effects.
Color Constraints use the color properties of the image to quickly select specific areas.

Brushing Panel Overview
Click the brush icon in the toolbar to open the masking controls.  By default this is below the Layers
panel in the top right dock.

Brushing panel open in default configuration.

Brush icon - Toggle the Brushing panel open and closed.
Show Pins - Select how the brush and gradient start points are shown.
Preset options - Quickly set desired adjustments.
On new layer - toggles brushing adjustments to a new or current layer.
Brush controls - Set the behavior of brushes and eraser.
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Gradient controls - Create smooth radial, planar gradients.
Show Mask controls - Show a preview of the masked area over the image.
Color Constraints - Advanced masking controls that allow you to select areas based on specific hue,
saturation, and luminance.
Mask options - Suppress selection noise and feather the edge of the selection.
Reset - Reset the mask to start again.
Close - Close the brushing panel.

Pin controls
Pins show where the start point of brushing effects and gradients are located on the image and give
you control over where they are placed. You can drag a pin to move the brushing affect or gradient.

Show Pins dropdown set to Auto.

Auto shows all pins when the cursor is over the image. The pins are hidden when the mouse is not over
the image.
Always shows all pins.
Active only shows the active pin.
Never hides all pins. Useful if you find pins distracting and do not want to move brushing effects
around the image.

Brushing Presets
The brushing presets allow you to quickly choose a desired effect. Each preset has a corresponding
adjustment or set of adjustments that goes with it. For example if you choose Clarity, the Clarity slider
in the Basic panel will be set to 80. Enhance Iris will change three settings in the Basic Panel: Exposure,
Clarity, and Saturation.

When the on new layer checkbox is enabled, a new layer will be created when a brushing preset is
selected. This is useful if you want to isolate each type of edit to its own layer.

After you select a preset, any brushing or other mask settings you apply to the image will show the
effect.
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Preset dropdown list with Burn selected.

Custom brushing presets
The presets shown above are included with Exposure. You can make your own brushing presets.

Brushing Preset dialog options.

1. Make any desired edits or select a preset from the Presets panel.
2. Click the menu icon and select Save As Preset.
3. Name your preset and create a new category if desired.
4. When complete your presets will show below the factory preset list.

Use the same menu to delete or rename your brushing presets.
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Brush Controls
Brushes enable you to quickly create precise selections to apply adjustments. The effects will only
apply to the area you designate. Essentially, you “brush” adjustments on specific areas of your photos.

Brush selection and adjustment.

Brush A and B allow you to set different parameters. For example, you can configure Brush A to be a
large brush for subtle adjustments and configure Brush B as a smaller brush for fine-tuning details.
Eraser removes brush strokes that you don’t want.

Each brush has a set of adjustments that go with it.
Size - overall size of brush
Feather - the size of the region from full affect to zero affect.
Flow - How rapidly the effect is applied with each stroke.

Switching Brushes
Keyboard shortcuts quickly switch between brushes.
Toggle Eraser: Hold Option (Mac) or Alt (Windows) while brushing.
Rotate through brushes and Eraser: Shift-Comma or Shift-Period.

Gradient Controls
Gradient controls enable you to make seamless, natural fades between effects. Our Gradient Tools
video demonstrates how to apply and use the adaptable gradients for making effects in Exposure.

Gradient controls on the brushing panel.
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Gradients are applied to a new layer when the on new layer checkbox is enabled. Uncheck if you want
to add a gradient to the current layer.

There are three gradient shapes available:

Radial applies your adjustments inside of an adjustable circular region, with adjustable feathering to
blend the adjustment outwards into your image. Radial gradients work in many different scenarios,
such as drawing attention to the subject in portraits, or they can be used creatively for fine art images,
landscapes, macro shots, and more.
Planar applies your adjustments in both directions outwards from the center line. This shape works
well in images with strong linear components, like landscapes, or architectural photos.
Half-Planar applies your adjustments in only one direction from the center line. The half-planar shape
is a great solution for darkening an overexposed sky, or selectively adding contrast on a horizon.

Active Gradient Controls
These controls allow you to individually adjust a specific gradient. If you have multiple gradients,
hover over the image area and click the pin for the desired gradient.
Erase allows you to use a gradient to remove effects from an area. Use it to refine brushing, gradient
and color constraint masks.
Collapse hides the gradient control lines, leaving only the pin in the image area.
Delete will remove the active gradient.
Opacity adjusts the strength of the active gradient.

Show Mask controls
Check Show Mask to show a preview of the mask over the image.
Click the menu icon to adjust how the mask is displayed.

Mask Options dialog.

Fill selects the whole image area.
Invert changes the mask to allow adjustments to appear everywhere in the image except for the area
selected.
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Color Constraints
Color Constraints are useful for quickly creating complicated masks based on color information in the
image.

Exposure's color constraints masking controls define detailed selections with minimal effort. Check
out our 3D Masking Deep Dive video, which demonstrates how to create layer masks in Exposure. It's
an excellent resource to learn the essential steps of the process.

Click the triangle next to Color Constraints to expand the controls.

Color Constraints controls expanded.

The 4 Arrows icon opens the Color Constraints controls to a separate resizable window.

Click the Gear Icon for a list of Color Constraint presets or to save a new preset. The presets are a useful
starting point in a range of common selection scenarios. They can be used for selecting various skin
tones, or skies, or brightness ranges.

Select hue, saturation, and luminance ranges to limit the mask to a specific range. On the sliders, the
top arrows select the range, while the bottom arrows control feathering. The hue wheel operates
similarly.
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You can also select any component using the eyedropper slider. Click the eyedropper, then the point in
the image you want to sample from.

Use this tool to define a luminance, saturation, or hue range. Repeat the process to reselect using a
different sample. To add other colors with the eyedropper, hold the Shift key. With each click, the
range is expanded to include more selected values.

Multiple Constraints
Multiple color constraints can be performed in the same step. To add another constraint, click the +
icon in the top bar of the Color Constraints controls. For a demonstration of how you can combine
multiple color constraints in a single layer, check out our Combining Color Casts video.

Each constraint is represented by a visualization in the top bar of the window. Right-click these
visualizations to reset or remove them.

Reusing the mask
Once a mask is defined by one or all of the color constraints to create a useful image selection, the
mask can be reused on other images with good success. With the ‘show mask’ option turned on, an
overlay is displayed in areas that are selected. These masks can be saved as a preset or copied and
pasted from one image to the next. The mask boundaries automatically recalculate for the content of
the image it is applied to. If the subject moves to a new position between shots, or if there are several
images captured in a similar environment, the same mask can be applied to all of them.

We demonstrate the process of coping detailed masks between photos in our 3D Color Masking video.

Mask Options
Sometimes image data can create artifacts in the mask that are not desirable. Use the Mask Options to
refine the mask and smooth the transition.

Suppress Noise adjusts the sensitivity of the mask noise filter. This is useful if there are jittery or
empty pixels inside the mask.

Feathering eases the transition between mask and unmasked areas using a blur around the edges.

Layers Panel
Layers play an essential role in controlling editing adjustments. They introduce an extra level of
control over effects. Think of a layer like a level or a group that contains a set of modifications. Each
layer provides separate control over all the effects assigned to it and can be stacked and blended with
limitless variety.
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Exposure's non-destructive layer system is powerful yet still easy to understand. Our Working with
Layers video demonstrates working with layers in Exposure. Check it out to see how to apply complex
editing tweaks without having to be a post-processing guru.

Each layer in Exposure is made up of two components:

● Adjustments: The combination of edits made using the editing panels or by a preset from the
Presets panel.

● Mask: The area where the adjustments are applied. Masks are also commonly referred to as
Selections, Brushing and Local Adjustments.

Exposure user interface with the Layers panel highlighted. Photo © Vincenzo Sagnotti

The Layers panel is located in the top quadrant on the right of the screen. The default configuration of
Exposure’s interface has it placed between the Overall Intensity and the toolbar for the Crop, Spot
Heal, and Brush tools.
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The Layers Panel in Exposure. The photo shown has five layers.
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1 - Layer Opacity - Sets the strength of the edits applied on the selected layer. Note the mask
thumbnails in Exposure are updated in real-time with this setting. Lowering the opacity will darken the
mask and reduce the effect the layer has on the photo.

2 - Add Layer - Creates a new, empty layer and mask.

3 - Layer Thumbnail - Layers do not include base adjustments to the Overall Intensity slider, spot
healing or cloning, crop and rotate, lens correction, and transform effects. Right-click the layer
thumbnail to access commands to copy, paste, or reset layer adjustments.

4 - Mask Thumbnail - Hover the cursor over the mask thumbnail to show the mask overlay on the
selected image. Right-click the mask thumbnail to access the copy, paste, invert, and reset mask
commands.

5 - Layer Name - Double-click to rename the layer or right-click and select ‘Rename Layer.’

6 - Menu Button - Access layer operations like copy, paste, rename, and delete. There are similar
operations that only affect the adjustments made on the layer, and other operations for just the layer
masks.
Additionally there are options to adjust the size of the thumbnail images in the Layers panel.

Layers Controls

Layer Order

Edits on each layer are rendered in ascending order. The bottom layer’s adjustments are applied to the
photo first, then the effects in the next layer are applied to the result of that. Click and drag to reorder
layers. Access the layer rename, delete, reset, and copy operations from the right-click menu.

You have freedom to apply adjustments in any order when editing, but we suggest arranging layers in
the following order:

1. Basic adjustments like exposure, contrast, clarity, and saturation at the bottom
2. Preset or presets
3. Brushing adjustments
4. Grain and overlays like borders or light leaks the top

Layer Masks

Every layer has a mask associated with it. The mask controls where the layer adjustments are applied
to the image. Masks are displayed in greyscale. Where the mask is white, the effects from that layer are
applied to the image. Where the mask is black, the effects from that layer are hidden.
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Layer with mask shown. Note warming effects of the layer do not affect the black area of the mask.

Layer Visibility

The layer effects can be turned off or on with the toggle on the left of the Layers panel. When off, the
layer will have no effect on the image.

Turn layer effects off with the toggle on the left of each layer. The layer displayed here is off.

Panel Tools

Layer Controls

There are several layer commands available from the right-click menu. These operations affect the
layer, editing adjustments, and layer mask. Adjustments to the Overall Intensity slider, spot healing,
cloning, crop and rotate, lens correction, and transform effects are not included in layers.
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Right-click on the layer to access a menu of layer-specific actions.

Adjustment Controls

Access controls for the adjustments on each layer by right-clicking the layer thumbnail.

Copying editing adjustments between layers is a fast and useful editing technique. For more precise
control over the settings copied from each layer, use the Copy Settings option from the Edit menu.
Learn more about the adjustment selection options in our Working with Presets video.

Mask Controls

Masks can be copied, pasted, inverted, or reset from the options in the right-click menu. This includes
color constraints, which automatically recalculate mask boundaries for the content of the image they
are applied to.
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The right-click menu provides several useful mask operations

Presets
At the heart of Exposure is an extensive library of presets. Each preset is a collection of settings for
Exposure’s editing controls which work together to achieve a certain look. Exposure’s built in presets
include film simulations for almost every film ever produced, creative looks not based on film, utility
presets for speeding frequently used editing operations, and more.

Presets can be used to create beautiful one-click looks. They can also be customized to fit your own
editing style. Using presets is a great way to explore new creative styles, speed editing, and enforce
consistency in editing.

The presets that are included in Exposure’s installer are factory presets. They can’t be edited, but you
can make user presets based on them. Each preset has a name, description, and category for grouping
with other presets. You can designate presets as favorite presets which can be easily filtered for quick
access.

Exposure has hundreds of presets that span the entire history of photography. Our Applying Film
Looks video will walk you through where to find preset types and point out some of our favorites.
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Presets panel showing films in the Color Films - Print category. The preset filter is set to display only color
presets.

1 - Preset Display Options - Switch between one, two, or three columns of thumbnails. The compact
list view displays the preset names without a thumbnail image.

2 – Collapse/Expand All - Click to open or close all preset categories.

3 – Save/Delete Preset - Click + to create a new preset. - deletes the currently selected preset. Note
that only user created presets can be deleted.
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4 - Preset Filters and Search Bar - Click preset filter categories to show only color, B&W, favorite, or
user-created presets. Clicking All will remove the filter. Type in the search box to perform a full text
search on preset names and descriptions.

5 – Preset thumbnail - Shows a sample of the current image with the preset applied. You can click the
star in the upper right corner to designate the preset as a favorite.

Preset Context Menus

Context menus for factory presets (left) and user presets (right)

Right-click presets to access their context menu. The context menus are slightly different for factory
presets since they can’t be modified.

Save to User Preset - Saves the factory preset as a user preset. Customize the name, description, and
category.

New Layer with Preset - Creates a new layer and applies the preset to it. See the Layers Panel section
for more details.

New Virtual Copy with Preset - Creates a new virtual copy of the current image with the preset
applied.

Audition Preset - Opens a comparison interface enabling you to preview and compare presets. See
the Preset Audition section below for more info.

Delete - Delete the user preset.

Edit Name, Category, or Description - Edit information about the preset.

Export - Export the selected preset to a file that you can share with another Exposure user. To import a
preset, simply double-click the file to automatically load it into Exposure.
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Saving Presets

Save preset dialog

The save preset dialog enables you to set information about the preset you’re saving.  Data in the
Name and Description fields can be searched in Exposure’s full-text preset search, so it’s best to enter
useful information in these fields.

The settings panel can be disclosed to select which editing operations are included in a preset. You can
choose to include or omit base adjustments, which affect the image prior to any layer processing.

Under layers, you can choose which panels to include. You can also select which edits to include from
specific layers. Edits which have been changed from their default settings are underlined.
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Preset Audition

Full Exposure window, auditioning presets with four cells visible. The unmodified image is shown in the
top left.

Preset Auditioning enables you to compare several presets against your unmodified image. To enable
auditioning click the spotlight button in the top toolbar when zoomed into a single image. When you
start the audition process, one comparison cell shows the unmodified image, and the rest are empty.

When Preset Audition is active, clicking presets in the presets panel will fill in the empty cells with
previews of the preset on the active image. When there are no more empty cells, the contents of the
oldest cell will be replaced. You can also drag presets from the panel into any cell.

Change the layout of the preset audition using the Layout control on the top toolbar. Available layouts
show two images (Horizontal and Vertical), three images (Rows and Columns), or four or six images in
a grid (Quad and Six).

Click Apply in an auditioning cell to apply that preset and end the auditioning process. Clicking Discard
clears the contents of the cell. This is useful if you have ruled out a particular preset.
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Culling the shoot to the best images or finding the perfect creative look is a simple process with
Audition mode. Check out the Comparing Photo Treatments tutorial on our website to see a
demonstration.

Crop & Rotate
Cropping can improve a photo in numerous ways, including directing the viewer's attention,
eliminating distractions, improving the composition, and more.

Select the crop icon on the editing toolbar to open the Crop and Rotate panel, or use the keyboard
shortcut, F2.

Aspect Ratio - Select from common crop ratios such as 1:1 (square) or 5x7, or any custom presets you
saved.
Orientation - Switch crop orientation between portrait and landscape.
Level Tool - Use to trace a line in the image that should be either horizontal or vertical.
Angle - Rotate image clockwise or counterclockwise up to 45 degrees.

Our cropping and leveling video demonstrates how to use these tools in a real-world scenario.
Additionally, you'll see how to apply cropping to batches of images simultaneously.

Portrait Touch Up
Exposure has the tools you need to create perfect portraits. The Spot Healing tool, Brushing presets,
and Portrait Touch Up multilayer presets allow you to quickly refine skin and features.

Spot Heal Tool
Spot healing enables you to quickly remove distracting elements from your images. It’s commonly
used in portraits, but is useful for removing distractions from images of all types.

Select the bandage icon on the editing toolbar to open the Spot Heal tool or use the keyboard
shortcut, F4.

88

https://exposure.software/tutorial/comparing-photo-treatments/
https://exposure.software/tutorial/cropping-and-leveling-images/


Spot Heal panel open in default configuration. Note the blue bandage icon in the toolbar.

Show Outlines - Select how the heal tool outlines are shown. Auto shows all applied areas when the
cursor is over the image. They disappear when you move the cursor away from the image for an
uninterrupted view. Always shows all applied areas while spot heal is open. Active shows only the
current area. Never hides all outline regions.

There are two sets of controls that share identical options.
Active Spot controls - Allow you to adjust the currently selected spot. This may be the spot you just
made or an earlier spot you clicked on to refine.
Brush controls - Adjust how the next brush stroke will behave. Once you have made the stroke it will
become the Active Spot and you can use those controls to refine it.

Heal/Clone dropdown
Heal - Mostly used for portrait retouching. Best for smoothly removing distractions.
Clone - Useful for areas with strong patterns like grass or trees.

Active Spot and Brush Sliders
Size - Decrease or brush size. You can also use the scroll wheel or [ and ] keyboard shortcuts to edit the
Brush size.
Feather - Control the transition from full to zero affect.
Opacity - How strong the effect is.

Reset - Reset the spot healing effects  to start again.
Close - Close the spot heal panel.

Spot Healing Example
While editing this image we notice a slight skin crease next to the jewel on this woman’s forehead.
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We’ll use Spot Heal to remove it.

Spot Heal open with image zoomed in to a skin blemish. Photo © Frank Salas

1. Click near the mark to set the image to 1:1 view.
2. Click the bandage icon or use F4 to open Spot Healing.
3. Adjust the Brush Size to be just larger than the blemish width. You can use the Brush Size

slider, scroll wheel or keyboard shortcuts [ and ].
4. Click on the area and brush along the line. Release when complete.
5. Exposure will automatically find and apply a sample area and the brushed area will become

the Active Spot.

90



Spot Heal Active Spot and Sample Area after brushing over the blemish. Note the two “dancing ants”
selection regions and connecting line.

6. You can click on the Active Spot or Sample Area to drag and reposition them as needed.
7. If the area is too small or the effect is not strong enough, adjust the Active Spot sliders.
8. Move to the next spot or click the bandage icon (F4) to close the spot heal tool.

Portrait Specific Brushing Presets
Exposure’s brush tool works great for retouching. The Masking section of this guide covers the topic in
more detail, but we’ll cover useful portrait specific brushing presets here.

Open the tool by selecting the brush icon to the right of the Spot Heal tool. The brush tool has several
useful presets listed in the dropdown. Some of these presets are well-suited for retouching portraits.

On the Brushing panel, notice the on new layer checkbox. When this is checked, Exposure will create a
new layer for each new brush preset you select. This is helpful because it saves you from accidentally
undoing or brushing over your edits to the previous layer. At the bottom of the panel, Reset will undo
all the brush strokes for the layer.

Whiten Teeth
Teeth whitening is an especially helpful retouching preset. It will brighten and reduce the color
saturation in the applied area.

Whiten Teeth Applied. Photo © Randy Kepple
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1. Click the Brush icon to open the brushing panel.
2. Select Whiten Teeth from the Preset dropdown.
3. Adjust the Size and Feather of the brush. It’s ok if Flow is high, we can turn down the effect

later.
4. Brush over the teeth or areas you want to lighten.
5. If the whiting area is too large, use the Eraser brush to remove the overflow. Hold Alt to active

the Eraser instead of clicking in the panel.
6. If the whitening is too strong you can turn it down using the Opacity slider in the Whiten Teeth

layer.
7. Click the brush icon or press F5 to close the brushing panel.

Enhance Iris
The Enhance Iris preset is a great way to make the eyes of your subject a bit more captivating. I’ll select
it from the dropdown menu. This preset will boost exposure, saturation, and clarity to make eyes more
bright and vivid.

Enhance Iris applied to the eyes of a leopard. Note the white dots in the Layers panel mask preview
indicating where the effect is applied.  Photo © Vincent Bernard

1. Click the Brush icon to open the brushing panel.
2. Select Enhance Iris from the Preset dropdown.
3. Adjust the Size and Feather of the brush. It’s ok if Flow is high, we can turn down the effect

later.
4. Brush over the eyes or areas you want to enhance.
5. If the enhanced area is too large, use the Eraser brush to remove the overflow. Hold Alt to

active the Eraser instead of clicking in the panel.
6. If the effect is too strong you can turn it down using the Opacity slider in the Enhance Iris layer.
7. Click the brush icon or press F5 to close the brushing panel.
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Soften Skin
An easy way to reduce the appearance of unwanted skin texture is to use the Exposure’s Soften Skin
preset. This tool works very well with the Color Constraint tools in the brushing panel.

1. Click the Brush icon to open the brushing panel.
2. Select Soften Skin from the Preset dropdown.

Selecting the Soften Skin brushing preset.

3. Find to Color Constraints section in the Brushing panel. You can manually adjust the
constraints but there are some preset options that quickly select useful areas.

4. Click the Gear icon next to Color Constraints and find a preset that covers most of the area you
want to soften. The effect will likely be too strong, we’ll adjust that in the next step.  In this
image the Skin preset captures the skin tones nicely.
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Color Constraints Skin preset.

5. If the effect is too strong you can turn it down using the layer opacity slider. If the softening
covers undesired areas, use the Eraser brush to remove the effect. Hold Alt to active the Eraser
instead of clicking in the panel.

6. Click the brush icon or press F5 to close the brushing panel.

Soften Skin layer using Color Constraints. Note the layer mask area in the blue box showing a subtle
masking around the face and the Opacity reduced to 63%.

Portrait Touch Up Presets
Exposure has portrait retouching presets that apply several layers all at once. They free you from
having to start from scratch for each image you retouch, saving  time. After one of these multiple-layer

94



presets are applied to your image, you can then use Exposure’s brushing to control the application of
each layer’s effects.

For a demonstration of the Touch Up presets, check out our Portrait Touch Up video. It shows how to
use the Spot Healing tool, and how to enhance eyes, and whiten teeth.

Preset panel showing Portrait Touch Up presets.

Touch Up covers the retouching basics. It includes a layer for softening skin, one for enhancing the iris,
and one for whitening teeth.

Touch Up + Background includes the three basic touch up layers and an additional layer that blurs
and darkens the background which helps you easily draw attention to your subject.

Touch Up + Red Eye includes the basic three touch up layers, and a layer with an effect that removes
red eye.

Touch Up Preset applied. Click on the black mask preview on the desired layer to start brushing in the
desired edit.
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The Touch Up preset layers are applied with black empty masks. Clicking on the Whiten Teeth mask
has opened the brushing to that setting.

As with all of Exposure’s presets, you can use the default settings, or you can customize each setting as
much as you like. You can create and save your own variations of these multi-layer presets for your
signature workflow and style.

Balanced, even skin tones are a great way to make your subjects look their best. Our Perfecting
Portrait Skin video demonstrates a few methods for clearing up skin in Exposure.

Basic Panel
The Basic panel is where you’ll apply the most fundamental and frequently needed adjustments to
your image - exposure, contrast, highlights and shadows, and more. At the top of the Basic panel,
select the Auto options to set the strength of the automatic adjustments.

Exposures automatic adjustment panel settings. Enable or tune the strength of any adjustments to fit
your editing preferences.

White Balance - Applies estimated white balance correction based on camera metadata.
Exposure - Applies estimated exposure correction for both under and overexposed images.
Exposure Bias - Sets the strength of the auto exposure correction. Use low values if the auto exposure
is making images too light, use high values if they are too dark.
Tone - Applies intelligent corrections to Blacks and Shadows, and Highlights and Whites to balance
overall image tone.
Dynamic Contrast - Applies corrections that lower and raise contrast without modifying color
saturation or hue.
Haze Level - Estimates the level of atmospheric haze present in the image. It’s particularly helpful for
backlit subjects and images shot into the sun.
Auto Enhance - Apply selected enhancement options from the panel.
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The Basic panel layout changes slightly when processing RAW vs. developed images such as TIFF or
JPEGs. RAW images contain unprocessed data sampled from the camera sensor. This information has
not yet been ‘developed’ or interpreted as an image yet, and therefore has a much wider latitude of
available adjustments. Camera profiles are critical when editing RAW images as they control the
interpretation of color from the RAW data. Some additional controls are available while editing RAW
images, such as the color temperature presets list on the basic panel.

Photographing outdoors or in changing lighting conditions can lead to photos with bright highlights.
That's when the brighter values in the image appear to merge into a blob. Our Reducing Blown Out
Highlights video demonstrates how to identify, analyze, and recapture details lost in bright areas.

Color | Black & White - Select the mode of processing, either Color or Black & White. Each mode has a
different selection of controls in the Color panel.
Profile - When editing RAW images, select camera profiles.
Browse - Click Browse to import and select from DCP camera profiles on your system.
White Balance Presets - Choose from a helpful selection of white balance options for various lighting
conditions. Select commonly used white balance settings such as As Shot, Daylight, Cloudy, and more.
White Balance Color Picker - Automatically adjust white balance with this tool. Select a color in the
image with the eyedropper that will become the neutral color. A good place to choose a white area
that is bright but not blown out is the teeth or the eyes.
Temp - Cool or warm an image up with the Temp Slider. Use the E and R keys to adjust temperature.
Tint - Adjust the white balance tint to magenta or green. Use the Q and W keys to adjust the tint.
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Exposure controls overall brightness similarly to a camera’s exposure compensation dial. Move the
slider to the left to decrease exposure and darken photos, or move it to the right to increase exposure
and lighten the image. Use the D and F keys to adjust exposure.
Contrast modifies the difference between the light and dark values in the image. Move the slider left to
decrease contrast and right to increase contrast. Use the A and S keys to adjust contrast.
Highlights restores detail in highlights by controlling the bright values in the image. Adjustments to
Highlights will make adjustments to the corresponding segment in the Histogram panel. Use the G and
H keys to adjust the brightness of light areas.
Shadows modifies the deepest shadows in the image to reveal hidden details or to add drama and
mood. Use the C and V keys to adjust the brightness of dark areas.
Whites will refine the brightest values to fine-tune overexposed areas such as specular highlights,
reflections, and light sources. Use the B and N keys to adjust whites.
Blacks will refine the darkest values in the image to fine-tune underexposed areas. Use the Z and X
keys to adjust blacks.
Dynamic Contrast adjusts image contrast. The effects of this slider are intelligently applied to prevent
unwanted color casts or hue shifts.
Haze Level counteracts the lowering of contrast in images from atmospheric haze.
Clarity increases or decreases local contrast in midtones impacting image texture. Positive values
increase contrast to reduce softening, negative values lower contrast. This can be used to soften
unwanted details in portraits. Use the O and P keys to adjust clarity.
Vibrance controls intelligently adjusts color saturation while avoiding oversaturation. It targets
normally saturated values in the image. Use the U and I keys to adjust vibrance.
Saturation adjusts the intensity of all colors in the photo. Negative values will remove colors from the
image; at an extreme value the image will be black and white. Use the T and Y keys to adjust
saturation.
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Brightening exposure in darker images is a simple edit to make in Exposure, but there are often other
adjustments needed, too. Check out the Fixing Underexposed Images video on our website and learn
methods for Identifying problems, correcting problems, and balancing adjusted tones.

Removing unwanted color casts from images is something every photographer has to deal with. With
the right tools, color tints or tinges are easy to fix. Our Fixing Color Casts video demonstrates a few
techniques for identifying and neutralizing color tints in photos using Exposure.

Color Panel
The Color panel contains tools which enable you to adjust colors in your photo.  It is located in the
lower section of the right hand editing dock. In Exposure’s default configuration it is located between
the Detail and Tone Curve panels.

Color panel
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Color Filter
The tools in the Color Filter section simulate the effects of shooting through a colored filter mounted
on the end of the lens. Color filters like these are frequently used in black and white photography,
where they enhance brightness or contrast in a selection of tones.

Color filter controls on the Color Panel

Preset - Click to browse and apply color filter presets.
Preset Menu - Save, delete, and rename color filter presets.
Density - Control the intensity of the color filter settings applied to the image. The density amount
must be set greater than zero to enable the filter effect.
Color - Controls the hue of the applied filter. Click the color chip on the right to access advanced
controls for selecting the filter color.
Cool/Warm - For quickly adding a creative warming or cooling filter to the entire image.
Preserve Brightness - Prevent the applied color filter settings from lowering the overall image
brightness as an analog filter would.

Detailed Adjustments
The Detailed Adjustments tools provide fine control over colors in the image. They enable you to
manipulate aspects such as the hue, saturation amount, and brightness of each color.
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Detailed Adjustments section of the Color panel.

Preset List - Click to browse and apply customizable color filter presets that only use the Detailed
Adjustment controls.
Preset Menu - Save, Delete, and Rename presets for the detailed color adjustments controls.
Group By - Arrange the color controls in groups by type or by color. HSL option selected in the image
above.
Hue - Adjust the color balance of each hue. For example reds can be made to appear more orange or
more magenta.
Saturation - Control the strength of each color tone.
Luminance - Set brightness of each color.
Compact - Enables a more compact layout for the detailed adjustments. Controls may be grouped by
either HSL or Color.
Targeted Adjustment - Click the up/down arrow icon, then click a color sample in the image and move
the mouse up or down. Exposure adjusts matching colors over the entire image as the mouse is
moved..

Advanced Color Editor

The Advanced Color Editor builds on Exposure’s unique 3D color masking to enable vastly greater
control of color modifications. For example, a model’s blue dress can be changed to red in just a few
clicks. Click the Advanced Color Editor control in the color panel to bring up the editor’s resizable
window.
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The Advanced Color Editor showing a replacement from blue to green..

The controls are divided into two columns. Convert From Color enables selection of the color range
you are targeting for change. The To Color column defines the color rage that will replace it.

Select hue, saturation, and luminance ranges for the from and to colors. On the sliders, the top arrows
select the range, while the bottom arrows control feathering. The hue wheel operates similarly.

You can also select any component using the eyedropper slider. Click the eyedropper, then the point in
the image you want to sample from.

Replacing Multiple Colors

Multiple color replacements can be performed in the same step. To add another replacement, click the
+ icon in the top bar of the Advanced Color Editor.

Each replacement is represented by a visualization in the top bar of the Editor window. Right-click
these visualizations to remove or reorder them. You can also control how they affect the image by
choosing to match on input or cumulative values.
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Learn how to color grade using complementary colors on the color wheel to produce a high contrast
and vibrant result. Check out how to make an orange and teal look with Exposure's Advanced Color
Editor in the Complementary Color Grading video on our website.

Black and White Processing
Our Black and White Editing video demonstrates the process of converting color images to stunning
black and white photographs in Exposure. Check it out and learn how to control the conversion
process, prepare the color image for conversion, and what to do after the image is black and white.

Preparing color images
When deciding on a photo to convert from color to black and white, consider the textures, lines, forms,
shadow, tonal contrast, and quality of light in your photo. In the absence of color, these qualities
become even more important.

When possible, we recommend working with a RAW image because it contains the unprocessed sensor
data from your camera. This enables you to make dramatic changes to the look of a photo without a
loss in image quality.

Make basic edits on your original color image so that it’s correctly exposed and white balanced, and
has strong colors and contrast. You’ll also want to do any noise reduction while the image is in color.

Black and White Presets
Exposure contains dozens of black and white presets to achieve a high quality black and white
conversion. These can be the final look or a starting point for your conversion.
Expand the Presets panel.
Click the B&W category to show all black and white presets.
Browse the presets to find a look you like.

Basic Panel
You can manually change to Black and White using the Black & White option at the top of the Basic
panel.
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Basic panel set to Black & White mode.

This retains all Basic panel settings and applies the default color sensitivity settings in the Color panel.

Color Sensitivity
When the image is in black and white mode, Exposure’s Color Panel switches to provide Color
Sensitivity controls. This is useful because actual black and white film responds to colors at different
rates. Film A may be very sensitive to reds while film B is sensitive to blue colors. In this example film A
will show red areas as brighter than B. An image taken with film B will show blue areas brighter.
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Color panel in Color Sensitivity mode.

Default is the default color sensitivity setting. There are also presets that favor red, blue, or green, one
for an early vintage orthochromatic look, and more.

Detailed HSL Adjustments and the Advanced Color editor are not available in Black and White mode.

Related Panels
While all panels can be used for editing black and white images, the following panels have sections
that relate specifically to certain types of black and white photography.

Split Toning
Split toning started as a side effect when treating prints to extend their longevity. Many early black and
white processes used chemical toners like sepia or selenium. The choice of tone can influence the look
and feel of an image.

Split Toning controls are found in the Tone Curve panel. The panel contains a variety of presets specific
to Black and White photography. Learn more about the Split Toning controls in the Tone Curve Panel
section of this guide.
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Grain
Many traditional films had uniqure grain patterns. Changing the grain behavior is not unique to black
and white photos, but goes a long way to refining the character of the image. Learn more about the
Grain controls in the Grain Panel section of this guide.

IR
Some black and white films are sensitive to Infrared (IR) light. This can give an ethereal look and
enhance the contrast between deep blacks and pure whites.

There are many infrared film simulations in the B&W Infrared category of the Presets panel to find
complete looks. Browse the presets in the IR panel to find partial presets to modify an existing edit.
Learn more about IR controls in the IR Panel section of this guide.

Our Spot Color Effects video demonstrates how to create a black and white image that has some color
elements left behind. It’s a powerful method of calling attention to the subject in a photo.

Sharpening Panel
Applying sharpening effects to images is common in post-processing. Photographers use it on almost
every image they edit. The controls on the Sharpening panel are calibrated for correcting sharpness
issues in images. The controls on the Focus panel are similar to these sharpening controls, but they are
designed for stronger creative applications.

For a demonstration of adding sharpening to images in real-world scenarios, check out our
Sharpening Techniques video. It will show you how to get great-looking results by adding sharpening
effects at various periods in your editing workflow.

Amount - Controls overall sharpening. Hold the ALT key while moving the slider to visualize the effect.
Radius - Controls the width of the sharpening area around each edge. Hold the ALT key while moving
the slider to visualize the effect in the preview.
Detail - Adjust how much of the fine textures, such as pores, wrinkles, or fine body hair on the skin are
emphasized. Raising it too high will give a grainy look.
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Masking - Adjust how much contrast there needs to be between colors for them to be sharpened. Turn
it up to only sharpen strong edges. Hold the ALT key while moving the slider to visualize the effect.

Noise Reduction Panel
Eliminating unwanted noise from images can help them read more crisp and clear. Balanced noise
removal will make noise disappear without making it blurry. Because noise reduction effects can
reduce image sharpness, photographers often add sharpening effects.

Head over to our website for a tutorial about reducing noise in Exposure. It demonstrates how to use
Exposure's profile-guided noise reduction profiles and how to reduce noise in JPEG and TIFF images
manually.

Exposure’s noise reduction system uses profiles based on camera characteristics. When using a profile,
use the following controls.

Select from noise reduction profiles for highly-effective noise reduction effects.

Noise Reduction profiles are based on the camera sensor’s physical characteristics, ISO setting, and
estimated electronic noise.
Camera profile. Select the camera make and model for accurate noise-reduction.
Luminance noise removal that mostly appears in brightness values.
Color noise removal for color noise.
Smoothing adjusts noise-sensitive smoothing that keeps edges crisp and clear.

Exposure’s noise reduction system can also be set manually. When dialing-in noise removal by hand,
use the following controls.
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Use manual controls to reduce noise in images shot with cameras that aren’t supported by Exposure.

Noise Reduction manual controls can be set by hand for reducing the appearance of noise.
Brightness is used with Detail to remove monochrome noise while keeping the image details intact.
Detail will preserve sharp edges when set at higher values.
Color removes color variations in the noise itself. Color removes the overall amount of color noise.
Smooth blurs patches of color to remove noise. Use it with the Color slider when removing color
variations from noise.

You can use color to enhance mood, add depth, or reduce distractions in images. Our Color Toning
video demonstrates methods for doing just that in Exposure.

Tone Curve Panel
The Tone Curve panel has several great tools for adjusting image brightness and contrast. They
provide you lots of power to quickly change the overall impact of the image. The panel is split in two
sections, one for adjusting the brightness of specific tones in your image, and the other is for adding
color toning.

Tone
The tone tools include the Curve Editor and a set of sliders. The tone curve represents all of the values
in the photo. Apply adjustments to the curve for control over the lightness and darkness of various
parts of your photos. The sliders at the bottom are for adjusting the curve without having to adjust
control points. The similarly named sliders on the basic panel provide more sophisticated adjustments
and will typically provide much better results.
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1 - Tone Preset - Displays the selected tone curve preset. Click to browse and apply available
customizable tone curve presets. This includes any custom presets you have saved.
2 - Menu Button - Save, delete, and rename tone curve presets.
3 - Curve Editor - The Curve Editor is a powerful tool for controlling the brightness and contrast of an
image. Edit the curve to make your images brighter or darker, and affect the contrast. Adjust the curve
by adding control points. Move control points on the curve to make changes, or use the sliders to raise
and lower sections of the tone curve.
4 - Contrast - Adjust contrast in the curve independently from control points with this slider.
Increasing contrast in the image will create a steeper region at the midpoint of the curve, creating a
more dramatic separation between light and dark areas in the image. Flatter curve sections represent
areas of lower contrast.
5 - Shadows - Lowering this control will intensify dark shadows; raising this slider will make the image
look faded. Note the dotted line below the curve from the Shadows slider value.
6 - Midtones - The midtones slider can be used for making gamma adjustments. Moving the midtones
slider to the right makes the overall image lighter.
7 - Highlights - Adjust the highlight values in the photo without going beyond the image white point.
The Highlights slider will only modify the brightness within the boundaries, it will not go past the white
point value set for the image. Note the dotted line above the curve from the slider value in the
example.
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These tools are great for adding punchy contrast and vibrancy to photos. The opposite effect can also
be achieved to even out exposure by darkening the highlights and bringing up the shadows. The
sliders on this panel control the curve independently of control points in the curve editor. Adjustments
appear as dotted lines in the tone curve.

Curve Editor
Add control points to the curve to change the lightness of particular tones in your photo. The bottom
axis of the graph is the tonal range of the unprocessed image, with shadows on the left and highlights
on the right. The vertical axis represents the adjusted tones, with dark values on the bottom and bright
values at the top.

Optionally, the curve editor is displayed in a resizable window.

1 - Channel - Select individual color channel curves. Curves can be applied to all channels together in
an image, or to each channel individually.
2 - Tone Curve Eyedroppers - Define pure black, 50% grey, and white values in the image with these
eyedroppers. Sample the appropriate tone in the image, and Exposure will automatically adjust the
image tone and color based on that value.
3 - Curve Editor Window - Click to open a resizable view of the curve editor. A larger view simplifies
working with points in the curve. When open, select the same button to send the curve editor back to
the panel.
4 - White Point - Brightest value in every image. Lower this point to decrease the impact of blown out
highlights.
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5 - Curve - The curve is a line representing the tone vs brightness values of the image. A straight line
represents no adjustments are applied to the image. Adjustments made with the sliders on this panel
will display as a dotted line in the graph.
6 - Control Point - Add, edit, and delete control points along the curve to modify image tones. The
selected control point will be an outline rather than a solid dot.
7 - Black Point - Darkest value in every image. Raise this point to create a faded look with milky blacks.
8 - Input - Lists the brightness value of the selected point on the tone curve. Curve adjustments are
specified as a function from input level to output level.
9 - Output - New brightness value of the selected point with tone adjustments applied.

Click on the tone curve to add a new control point. Move control points to make changes, including the
black and white points at the ends of the curve. Drag upward to brighten the value and downward to
darken it. Move laterally to select different tone ranges. Drag unwanted control points outside of the
editor to remove them from the curve.

Split Toning
Toning in photography is the addition of a color to a photograph without changing the image
brightness. Split toning is a variation of toning where separate colors are added to specific values in
the photo, such as the highlights and shadows. This adds a level of perceived sophistication to the
image, and can enhance a cinematic mood. For example, Sepia toned black and white photos have a
recognizable vintage brown look.

Watch our Split Toning Effects video for a demonstration of how to use the toning controls to create
beautiful effects.

Applying Split Toning Effects
There are lots of fully customizable split toning presets in the dropdown list. Select one of the preset
options and then make adjustments to customize the effect. When saving custom toning presets,
create categories to organize with submenus. Hover over toning presets to preview the effects on the
image. Select a preset to apply it to the image.

Split Toning section. The Creamy Highlights/Cyan Shadows preset is applied in this image.
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1 - Split Toning Preset - Lists the selected preset. Click to browse and apply customizable split toning
presets. This includes any custom split toning presets you have saved.
2 - Menu Button - Save, Delete, and Rename split toning presets.
3 - Gradient Strip - The strip represents the luminosity range of the image, or the measure of
brightness in the image’s values. It is easy to visualize with black and white images. Light areas are
represented by the right side of the strip, and dark tones are on the left.
4 - Color Stop - Drag each color stop to designate the tones in the image where it is placed.
5 - Color Slider - Control the hue of the selected color stop. Click the color chip on the right to access
advanced controls for selecting the toning color.
6 - Strength Slider - Adjust the amount of toning applied by the selected color stop.

Select each color stop and adjust its strength, color, and the tones that it affects. To only apply a single
tone, set the strength of one stop to zero.

LUT Panel
LUTs or “Look Up Tables” are files that define a color transformation. They are often used to impart a
creative cinematic look to photographs.  Exposure doesn’t create LUTs, but it can use LUTs created in
other programs. LUTs can be purchased or downloaded for free from various sources. You can also use
LUTs produced by a video editing program to achieve consistent looks in still images for the same
project.

LUT selector - Select from imported LUT files that appear in the list.
Intensity - Control the strength of the applied LUT.
Color Space - Select the color space of the LUT you are applying. Most LUTs downloaded from the
internet are designed for sRGB. You can always change the color space in the LUT panel.
Browse - Click Browse to open the LUT browser window.
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Browse LUTs window

1 – Search - Select from imported LUT files that appear in the list.
2 – Thumbnail Size - Control the size of the thumbnail previews in the browse panel.
3 – Import - Import new LUT files into Exposure.
4 – Close - Cancel and close the window.
5 – Apply - Apply selected LUT file to image and close the browse window.

Vignette Panel
Vignetting is an adjustment in brightness at the edges of an image. Vignettes most often darken the
edges, but brightening vignettes are useful in some situations. It is a dynamic artistic element that can
strengthen energy and mood in a photo, or subtly draw attention to the subject. The appearance of
vignette effects can be widely varied, from a sharp mechanical edge, to a free-flowing organic look that
blends seamlessly with the image.

The Vignettes tutorial on our website demonstrates how to apply vignettes to your photos.

Create and modify vignette effects with the tools in the panel. The presets are great starting points
when creating a vignette. Browse the presets in the list to display their effects on the selected image.
Click to apply, then customize the vignette with the sliders.
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Vignette panel.

1 - Vignette Preset - Select from several preset vignettes, including any custom presets you have
saved. An asterisk will appear when adjustments have been made to the selected preset.
2 - Menu Button - Save, delete, and rename presets.
3 - Amount - Control the strength of the applied vignette effect. This slider ranges from -100 to 100.
Positive values darken the edges. Negative values lighten edges. At zero, the vignette isn’t visible and
all the other controls are disabled.
4 - Size - Control the radius of the vignette. At low values most of the image is covered by the vignette.
As it is set higher, more of the photo is shown.
5 - Roundness - Changes the shape of the vignette. Set the slider to the right for a vignette that is a
perfect circle, set it left for a rectangle vignette with rounded corners.
6 - Softness - Control how the image fades into the vignette effect. Low values give a hard edge, and
high values make it increasingly subtle.
7 - Distortion - Integrates random ripples in the vignette shape for an irregular look. Turn distortion up
to make the shape of the vignette more lumpy.
8 - Lump Size - Sizes the lumps introduced by the distortion slider. Turn it low and that the ripples at
the edges of the vignette are smaller. Higher values make larger ripples.
9 - Vignette Location - By default the vignette is positioned at the center of the photo. Click to move
the center of the vignette to another location.
10 - Random Seed - Clicking the Random Seed button will vary the look of the vignette by changing
the placement of the lumps. Click it a few times to experiment with different looks. The number next to
the button allows you to reproduce a particular distorted look later.

Vignettes are a dynamic artistic tool that can strengthen energy and mood in a photo or subtly draw
attention to the subject. The Irregular Vignettes video demonstrates how to make a creative vignette
from scratch.
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Overlays panel
Photo overlays are a great way to add creative styling to photos. Overlays can create unique texture,
mood, or to give images a vintage feel. Use the three different overlay types to construct a deep
textural look. Modify components such as borders, textures, or light effects individually with their own
set of controls.

1 - Border Preset - Select from preset borders, including any custom border presets you have saved.
Modify how the border appears on the image with the controls in this section.
2 - Randomize - Randomly apply a border from the selected category.
3 - Flip Horizontal - Flip the border across the horizontal axis.
4 - Flip Vertical - Flip the border across the vertical axis.
5 - Invert - Invert the brightness of the applied border.
6 - Zoom - Scale the applied border.
7 - Opacity - Set the visibility amount of the applied border.
8 - Blend Mode - Select how border effects are blended with the image. Set it to control the opacity of
the effect, or have it brighten with screen or darken with multiply mode. Overlay applies both
brightening and darkening effects, and hard light reverses the effects.
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1 - Light Effect Preset - Select from preset light effect overlays, including any custom light effects you
have saved. Modify how the light effect image with the controls in this section.
2 - Alignment - Control the placement of the light effect overlay. Move Freely enables you to place
light effects anywhere in the image. Stretch to Fill scales to overlay image to match the photo size.
3 - Move/Rotate - Position the applied light effect overlay with controls in the preview area. Not
available when using stretch to fill.
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1 - Texture Preset - Select from preset light effect overlays, including any custom presets you have
saved. Modify how the texture overlay affects the image with the controls in this section.
2 - Protect - Remove the effects from texture and light effects overlays. Removal is focused on a
customizable location.
3 - Protect Location - Specify the center of the area to protect.

Focus panel
The focus panel controls are designed for creative sharpening and blurring effects. Select from presets
to give images a unique blurry glow like glamour shots from the 90’s, or apply sharpening to tighten up
edge contrast towards the end of editing. The controls on this panel apply much stronger effects than
the sliders in the Sharpening panel.

1 - Focus Preset - Select from several presets, including any custom presets you have saved. An
asterisk will appear when adjustments have been made to the selected preset.
2 - Amount - Control the strength of applied unsharp masking.
3 - Radius - Radius for unsharp masking, relative to image size rather than pixels.
4 - Threshold - Controls the minimum brightness change that will be sharpened. This can be used to
sharpen more pronounced edges, while leaving more subtle edges untouched.
5 - Sharpen Brightness Only - Preserve color by applying sharpening to only the brightness channel.
6 - Opacity - Control the visibility of applied blurring effect.
7 - Radius - Distance features are smeared. Relative to image size rather than in pixels.
8 - Lens Warp - Amount blurring affects the edges of the image relative to the center.
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Grain panel
Film grain is the random texture of processed photographic film. The visual appearance of grain can be
widely varied, from chunky grain of vintage black and white film, to a subtle grain that barely kisses
the highlights. Whichever grain look you’re after, Exposure’s presets are great starting points. Hover
over the preset names in the grain preset dropdown menu to preview their effects on the image. Click
to apply a preset, and then customize the grain with the sliders.

Our Adding Film Grain video teaches the fundamentals of controlling grain effects to enhance your
photos and spot the differences between digital noise and analog grain.

Grain panel. When applying grain effects, zoom the view to 1:1 or 100% magnification. This gives you the
clearest view to evaluate the shape and amount of grain in each range of tones in your image.

1 - Grain Preset - Select from several grain presets, including any custom presets you have saved. An
asterisk will appear on the preset name when custom adjustments have been made to it.
2 - Menu Button - Save, delete, and rename grain presets.
3 - Overall Grain Strength - Control the overall visibility of grain in the image. Adjusting this slider is a
good way of making grain more visible or subtle without changing the grain shape and distribution.
4 - Amount - Adjust these sliders to control how much grain appears in the highlights, midtones, and
shadows separately.
5 - Roughness - Changes the contrast of visible grains.
6 - Color Variation - Increase the visibility of color in the grain effect. If you prefer monochrome grain,
set this slider to zero.
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7 - Push Processing - Push Processing simultaneously intensifies the amount of contrast in the image
and the visibility of the grain. It is useful for simulating darkroom techniques to enhance sensitivity of
film by increasing the time spent in developer chemicals.
8 - Size - Enable the automatic checkbox to set grain size based on specific film formats. Then move
the relative size slider to adjust the size of the grain lumps relative to that film format. With Automatic
turned off, adjust the pixel slider to directly set the size of the applied grain.

Emulating Real Film Grain
When simulating grain effects from real film, consider the following criteria: where the grain is present
in the image (such as in a specific tone or hue), how much of it is visible, and what it looks like.
Exposure has controls for each of these aspects of the effect. Additionally, Exposure will adjust the
grain placement if edits are made to contrast or exposure.

Note the grain effects in this example. The image is magnified at 200% to show details and grain size.
When you add strong, large grain effects, also add a subtle amount of blurring to help the effect appear
more realistic.

Clumpiness
Individual film grains can only be seen with a microscope. The little fractal lumps you see in film are
clusters of many overlapping grains. We use the term “grains” when referring to the visible lumps,
since that is what most people mean.
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Distribution
One secret to the great-looking grain in Exposure is the irregular clumpiness. Real film grains clump
together beautifully, but not in a rigid structure like digital noise. Grain lumps that are distributed
randomly will look most natural to the human eye. Some film stocks will show more grain in
highlights, while others show them in midtones, or shadows. Control the distribution of the grain with
the Amount sliders.

Roughness
One of the basic rules for grain is the faster the film speed, the greater the tendency towards
graininess. Developer and developing temperature can also affect the visible graininess in film. To
simulate a grainy film, use higher values of Roughness and introduce Color Variation.

Push Processing
One film photographer technique for getting the most out of shooting is to adjust the film speed with
chemical processes. Pushing and pulling film (increasing/decreasing light sensitivity) is a darkroom
technique that enhances the film’s tonal range. Take a 400 speed film, for example: if it were pushed to
1600 speed, the film grain would be more pronounced and the image would have increased contrast.
Use the Push Processing slider to increase the appearance of grain and add dramatic contrast.
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Blur
The sharpness of film is the perception of good edge distinction (acutance) between details in a photo.
With real film, if you make a huge enlargement, you won’t see any detail smaller than the grain size. It’s
the grain itself that makes the details. One of the easiest ways to see if film grain is fake is if image
detail is smaller than the grain. Real film will be blurry beneath the grain.

IR Panel
Infrared photography captures a different part of the light spectrum than traditional photography. The
different wavelengths captured in this way create false-color or black and white images with
dreamlike, psychedelic characteristics. Other attributes of IR photos include very dark skies,
penetration of atmospheric haze, and portraits with a milky glow to the skin.

Infrared Controls

Exposure user interface. Expanded IR (infrared) panel.

IR Preset Dropdown selects from presets that only use the controls on this panel.
Menu Button houses controls to save, delete, and rename presets.
Color Contrast adds what’s known as the “Wood Effect” in analog infrared film photography. In black
and white, this makes blue skies appear dark, while greens of foliage have a bright glow. For color
applications, this gives foliage a red or pink tone.
Halation Opacity is the bloom, or glow, around the bright values. Photographic films typically have a
backing layer to prevent halation. That layer isn’t present in Infrared film.
Halation Spread controls the distance of the glow from the highlights, or the width of the bloom.

Infrared Presets

The infrared spectrum of light is closer to that of thermal imaging than the visible wavelengths
captured by traditional film or camera sensor. Infrared wavelengths penetrate atmospheric haze better
than visible light, making Infrared film popular for landscapes.
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The presets in Exposure can be used creatively for any subject. Especially the color infrared selections,
which can give photos a psychedelic aesthetic. To make the effects more subtle, fine tune the strength
of the look with the layer Opacity and the Overall Intensity sliders.

Black and White Infrared

The “Wood Effect” in black and white infrared photography will noticeably darken skies and oceans
and brighten greens like foliage. The behavior is mainly caused by greenery strongly reflecting light,
causing the distinctive glow. Analog Infrared film records radiant heat from objects, so the sky and
ocean usually appear dark because they absorb light. Green from foliage, on the other hand, glows
brightly because of the reflected wavelengths.

The “Wood Effect” can create more extreme contrast between the dark field of empty sky and bold,
bright clouds. Similarly, bright highlights on crashing waves can benefit from the same treatment. In
analog film, the darkening effects of IR films were enhanced by the use of color filters.

Color Infrared

The “Wood Effect” in color infrared photography makes green foliage appear bright red. With infrared
film, the shade of red or pink could be used to determine the health of plants.

Kodak Ektachrome EIR
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Exposure presets displayed from left to right, Kodak Ektachrome EIR with green filter, orange filter,
yellow filter, and the original image.

Infrared-sensitive transparency film with fine grain and medium sharpness. Color filters were used in
conjunction with color infrared film. This blocks out visible light in specific spectrums. The presets in
Exposure simulate the use of the common color filters green, orange, and yellow.

Bokeh Panel
The term ‘Bokeh’ refers to the visual quality of the out-of-focus areas of an image. It’s a phenomenon
that occurs in several different varieties depending on the lens. Exposure’s creative focus tools on the
Bokeh panel replicate the unique characteristics of many lenses and other creative effects.

When the panel is open the focus region controls appear in the image in the middle of the screen.
When the panel is closed, these controls disappear, but the blurring effects will remain. To preview the
effect without obscuring the image with controls, close and open the panel. Use Cmd+Zero or
Ctrl+Zero to toggle the Bokeh panel.

See how to add and control blur in Exposure in our Creative Focus Effects video. It explains how to
apply advanced editing techniques such as highlight boosting and grain matching.

123

https://exposure.software/tutorial/creative-focus-effects/


Bokeh Controls
Control where the out of focus effects appear with focus regions. They specify areas to protect from
the blur. There are three different types of regions: Radial, Planar, and Half planar. Add a noticeable
blur before placing a focus region to visualize the placement of the effect. Once you position the effect
where you want it, adjust the blur settings to your preference.

Focus Regions

Show Mask will display the grayscale mask for the blurring effects when pressed. White regions in the
control mask are fully protected from the blur. Black areas in the mask apply the full effects of the blur.
Add Radial Region applies a controllable, round focus region. This is a great option for portraits to
draw attention to the subject. Click and drag within the region to move it. Stretch and resize with the
handles. Drag the dotted circle to adjust the transition from clear to blurred.
Add Planar Region applies a region that will blur the image in both directions from its center line. Use
this type of region to create a tilt-shift look. Move the region by dragging. Click and drag the solid line
to change the angle. The movable dotted lines indicate where the blurring effect reaches the
maximum.
Add Half Planar Region creates a half of a planar region, which will blur the image in one direction
from the center line. The controls for this region are the same as with planar regions.
Reset back to a single region set in the default position.
Delete the selected focus region.
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Lens Controls

Lens Presets apply blurring effects from three different preset families. Creative aperture presets
create unique shapes in the out of focus specular highlights (bright points of light) in photos. Motion
presets add spin, spiral, and zoom effects. And Traditional Lens presets accurately simulate the
blurring characteristics of popular lenses, such as the creamy blur of a Canon 85mm f1.2, or the
distinctive hollow rings of a mirror lens.
Menu Button provides access to Save, Delete, and Rename preset commands.
Amount controls the maximum strength of the blurring effects. These are visible in black areas in the
mask. At zero no effect is applied.
Zoom adds smearing effects to the blur.
Twist adds a spin to zoom effects. Use this to create spiral and spinning motion.
Creamy controls the inward curve of the sides of the aperture shape. Positive values create a smooth,
creamy look. Negative values create hollow-shaped bokeh.
Curvature controls the edges of bokeh shapes. Positive values are more round and negative values are
more star-like.
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Aperture Shape sets the shape of the aperture opening. The aperture shape effects are most
noticeable in bright out of focus specular highlights. Click to select a different shape or cycle through
different options with the arrows.
Rotation controls the angle of the aperture opening. Drag the handle, or use the keyboard to set a
specific angle.
Threshold sets the brightness level for areas in the image to apply highlight-boosting effects. Raising
the slider makes more areas of highlights appear.
Boost the amount of brightening in highlight areas.
Strength adds grain effects in blurred areas. If the original image already has grain, blurring effects will
remove it. Reintroduce grain to blend with the original photo.
Size the grain to match the existing look. If you’re adding grain from the Grain panel, it’s best to turn
that panel off while you make adjustments to grain matching.

Lens Correction Panel
Lens corrections remove unwanted distortion, vignetting, or purple color fringing from chromatic
aberration. These issues are commonly caused by the type or design of the lens. Use lens correction
profiles to automatically apply corrective adjustments, or dial them in by hand.
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Lens Correction presets that you save are accessible from the gear icon.
Maker defines the lens manufacturer preset.
Model defines the lens type preset.
Distortion Correction - Apply lens distortion correction. Use a profile to automatically apply
corrections based on characteristics of the lens. Select manual correction and dial in the following
options by hand.

Barrel - control distortion by bending the image inward, or counteracting pincushion
distortion by bending the image outward.
Midpoint - control the correction more or less aggressively around the center of the image.
Asymmetry - control the shape of the distortion correction curve mostly in the image corners.

Vignette Correction - Apply vignette correction. Use a profile to automatically apply corrections based
on characteristics of the lens. Select manual correction and dial in the following options.

Corner - Adjust the intensity of light falloff in the corner, which lessens towards the center of
the image.
Midpoint - Control the intensity of light falloff in a region around the center of the image.

Chromatic Aberration Correction - Apply corrections for chromatic aberration fringes. Use a profile
to automatically apply corrections based on characteristics of the lens. Select manual correction and
dial in the following options.

Blue - Align the blue channel to the green channel. Use this when you see purple or green
fringes.
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Red - Align the red channel to the green channel. Use this when you see cyan or red-magenta
fringes.

Our Correcting Chromatic Aberration and Color Fringing video demonstrates how to remove
distracting color fringes and how to balance the effects you apply.

Defringe Panel
Color fringing is a form of chromatic aberration caused by the camera sensor. Color fringes can occur
anywhere within an image, but it’s most common at the edges of high contrast areas. Branches
silhouetted against a blue sky is a good example. The Defringe panel has controls to selectively adjust
these areas to remove color fringes.

1 - Defringe Presets - Select from several defringe presets, including any custom defringe presets you
have saved.
2 - Saturation - Adjust how saturated the fringe color has to be in order to be removed.
3 - Size - Control how far from edges the fringes cover.
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4 - Radial Weight - Weights the strength of the effect away from the center.
5 - Sensitivity - Control how sensitive the defringe will detect edges in the photo.
6 - Fringe Color - Enable removal of common fringe colors by selecting the checkbox. When a color
fringe option is selected, the Hue Shift and Range controls appear.
7 - Hue Shift - Slightly adjust the selected fringe hue. For example, green can be shifted to include
more yellow or blue.
8 - Hue Range - Adjust how wide the range of colors are that are affected.
9 - Add Custom Color - Click to add a custom defringe color.

Transform Panel
Apply adjustments to correct image perspective and skew issues with the Transform panel tools. These
controls are far more powerful than the rotating and leveling performed with the Crop tool. When
images suffer from major distortion issues, the Transformation panel is the best place to make
adjustments.

Vertical adjusts vertical perspective. This corrects issues such as buildings that lean away from the
camera. This type of optical distortion is called keystoning.
Horizontal adjusts horizontal perspective.
Rotate images up to 20 degrees in either direction.
Aspect ratio adjustments to make the image wider or taller. Sometimes keystoning corrections can
noticeably widen or shrink the image.
Scale the image. This is an alternative to using the constrain crop option.
X Offset image horizontally.
Y Offset image vertically.
Constrain Crop forces the crop to fully fit the image, regardless of adjustments made on this panel.
Gridlines remove all empty space at the edges of the image. Press and hold Alt/Option to display the
grid while moving sliders.
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